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Binary ICT Skills New Edition

Binary ICT Skills New Edition is a dynamic series designed to prepare students, employees, and
individuals for the technology-driven workforce. This series covers a broad spectrum of topics,
from basic computing to advanced digital skills, matching the growing use of technology across
sectors. It's designed to develop a thorough understanding of modern digital tools, crucial for
success in today'’s digital work environment.

The Binary ICT Skills New Edition series is a collection of eight textbooks, each focusing on a
critical aspect of information and communication technologies:

Modern Computing
Text Documents
Spreadsheets
Presentations
Databases

Graphic Design
Computer Science
Digital Business

Covering a wide array of topics, from basic computer operations to complex data analysis
and digital design, learners acquire essential skills for professional documentation, data
management, effective communication through presentations, and creative design. The series
also explores the essentials of computer science, including networking, and addresses the
latest trends in digital commerce and online business, covering cybersecurity concepts and
project planning.

Adapting to the Needs of Today’s Learners and Workforce

Global Standards Developed in adherence to international standards,

ensuring educational excellence.

Current and Evolving Content Regularly updated to include the é
most recent te-chr.wologlcal advancements and the latest versions of ISTE SEAL
software applications.

Versatile Teaching Approaches Supports diverse teaching methods,
including traditional, flipped classroom, and remote or hybrid learning

environments. (AJ

Localization Customized editions with feedback from local experts, i .
making the series culturally relevant and adaptable to diverse blnaryloglc
educational settings.



Key Features:

In-Depth Practical Learning

Each textbook is designed to provide a comprehensive
understanding of its subject matter, ensuring learners
are well-versed in practical applications of ICT skills.

Step-by-Step Instructional Design

The series offers clear, concise guidance, enabling
learners to grasp and apply complex ICT concepts
easily.

Project-Based Learning
Emphasizes project-based and inquiry-based learning,
promoting hands-on experience and deep understanding.

21st Century Skill Enhancement

Beyond technical skills, the series promotes critical life
skills like teamwork, problem solving, and effective
decision-making.

Workplace Relevance

With a focus on digital skills required in modern
workplaces, this series prepares individuals for
professional environments where technology is
integral.

Empowering Educators and Trainers

Accompanied by detailed guides for instructors, the
series supports educators and trainers in delivering
effective, engaging ICT education.

Join Us in Empowering the Workforce of Tomorrow
Binary ICT Skills New Edition is not just a textbook series;
it's a pathway to mastering the digital skills essential in
the modern workplace. Whether for high school students,
young adults, or professionals seeking to enhance their
digital proficiency, this series is an invaluable resource for
anyone looking to thrive in the digital era.

Binary ICT Skills New Edition
Rengineering Education

Contact us for more information at ict@binarylogic.net
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Text Documents

Overview
1. Creating a document
Formatting text BINARY
Advanced font formatting I CT
Images and graphics
Working with tables Text Documents

Check and print

2. Designing a document
Tabs and columns
Headers and footers
HTML and PDF
Mail merge
Advanced topics

3. Documents for a purpose
Advanced documents
Customizing content
Leaflets & Labels
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4. Documents and forms
Business documents
Document design principles
Business forms |
Business forms Il
Business reports



Sample pages

MODULE 1

Creating a document

In this module, you will learn how to create text documents and how to
make them look beautiful! You will also learn how to create long
documents for a class assignment or your school newspaper. Find out
how you can use color and borders around a text to make it easier to
read and insert images to make it appealing. Organize some of your data
in tables and learn how to print your document on paper after checking
all your mistakes or finding new words in Thesaurus.

Learning Objectives Tools

In this module you will learn: > Microsoft Word
> what the environment of > LibreOffice Writer
Microsoft Word is like. > Apple Pages
> how to write texts in different > Docs To Go
ways. for Google Android
> how to create a document > Microsoft Word
that is easy to read. for Andro
> how to use images, 3D models
and screenshots in your
document in order to make it
interesting and attractive.
> how to correct your mistakes.
> how to put your document on
paper.

 Skills |

After this module you will be able
to:
> use Microsoft Word.
> format text and paragraphs.
insert images.
insert 3D models.
use borders and shadings.

use Spelling to check for
mistakes.

use Thesaurus to find synonyms.

print your document.

TASK 2

Headers and footers

A page header is one or more lines of text that appear at the top of each page. Usually, it shows some
information that relates to the entire text, e.q. the itle of the document. A page footer is the text that
appears at the bottom of each page. Like the header, it may also show some information that relates to the
entire text, e.g. page numbers. You can use a header, a footer, or both, to make your document look more
professional.

You can insert predesigned headers or footers into your document and easily change their format, or you can
create your own header or footer, and save them.

To add a Header — i

> On the Insert tab, in the Header & Footer e
group, click Header. @

> Click Blank (Three Columns) to insert a Bk e Coumns)
blank header. @

> Type some information. For example, you
can type your name on the left, London at
the center and the date on the right. ©

> Click Close Header and Footer. @

st

Fact ven Page)

repr |_ctetometinrome, | _beshoteost, '

et 044 Page

[More Headers from Office.com{E 3 M LX)
additi

used in your document.

Edit Header]
isthe same as double-clicking the header area.

[ makes changes to the header, which

JSave Selection to|
saves

aheader which
you've designed for
O s e future use.

B i B
i I e

Every header and footer
has some default tabs
to help you align your

text. You can always
use your own, of course.

TASK 1

Formatting text

One of the most common tasks that we do on a computer is to write text. It can be
anything from a small note or an email to a friend, to a school project. Text is so
important that many different programs have been developed to create and edit it
Microsoft Word is a very powerful program, not only for writing but also for formatting
text, making tables and labels or even having fun with pictures and shapes. The
environment of Microsoft Word is simple and easy to use.

> Click the Search button,
type Word and press
Enter

The Ribbon is dynamic. When
you select an object, let's say a
picture, a new tab offering new
options for pictures will
appear. If you change the size
of the main window, the
Ribbon may hide some options.

> The program opens.

Thisis the Ribbon. From here
you canaccessall the tools in
Microsoft Word. Each tab
deals with a specific task,
e.g. the page layout.

Grouping the buttons is very important,
because some buttons do similar things. For
example, the Font group gives you all the
necessary tools to format the font of your text.

Rulersallow you to align

Theseare the

g
size of atable. theZoom slider.

Here, you can

Each tab consists of
groups with buttons
and drop-down lsts.

This is how the program

organizes its features.

The whiteareais the
“page” where you can
type your text.

document or you
can zoom inor out.

To add a footer: bt Do oo Rorces Mol Reden Vien W Sowcn
v o

e

B I Searssen et
> On the Insert tab, in the ormroes O - S <l Lo soir SN ) o
Header & Footer group, e A 7 e e ] o s e
click Footer. @ — P ———
> Click Banded. @ Your name [ "B

> The number of the page

will be displayed at the Topommy oty b
bottom of the page. © P Gl e e
" amendme o
> On the Header & Footer — -~ = = ‘ A
tab, in the Close group, derve fom the iver el ]
click Close Header and Thames e ‘ )
Footer. @
nom =
= ==
| ’ == :
| T
| I
More Options

On the Header & Footer tab, you
can find all the necessary tools you
need to edit the headers or footers
in your document. Let's see some of
them!

leader & Footer 0O Search

V] Diferen Fist Page
) Diferent 00 & EvenPages

o) Text
See the rest of your text as you i
edit your header and footer.

Wome Imat Deign loyool Rleences Moliogs Reew View Hep | HeaderFootr > Sesch

5 Hoow || Dotemreance [ Zrenset =
DRRBEEms 0 |ammoh.. [Emnn e K
< Mombers  Time - s pcires rooter 4 Show Documes Text B et asgrmen T o Footer
[
(Header 5] The [ group, J T Navigation} (lnsmaub,) Decide the
FooterTIm asthe name h
allows you to indicates, allows buttons you your header or
insert new youtoinsert needto navigate footer will have
headers and objects ke from the header from the top or
footers or apply Pictures or the tothe footer and from the bottom
page numbering. Date & Time. vice versa. of the page.




Text Documents

Sample pages

84

92

To add text to a template:

> Click the placeholder of the
text you want to replace. @

> Type your text. @
> Save the file.

A lot of people use templates
to create their CVs or letters.

It's easy, fast and can help
you prepare a perfect
document.

i

Table of C

" FIRST NAME LAST NAME

ALk o TPl

EXPERIENCE

e T R

ALEX FORD
©

[r—

© EXPERIENCE

If you are witing a book or a document with many pages, you will need a way to find out quickly where a
particular subject is. To do this, you can add a table of contents;

Type the following paragraphs:

Characteristics of each planet
Mercury

It is named after the messenger
of the gods of ancient Rome. It is
the smallest planet in our solar
system.

Venus
Itis the brightest planet in the
sky. It appears in the east as the
“morning star” and as the
“evening star” in the west.
Earth

Itis the only planet known to
have living beings on it. Its
atmosphere is composed mostly
of oxygen and nitrogen.

To change the starting numbx

> Select the numbered lst.

> On the Home tab, in the
Paragraph group, click the
arrow next to the Numbers
button. @

> In the list, click Set Numbering
Value.

> In the Set Numbering Value
window, in the Set value to
box, select Il. @

> Click OK. @

> The numbering wil change.

It's also possible to make a second
list within the existing list, This is
called multilevel list numbering
Type the following

The Michigan ECCE

has these sections:

Listening

GVR (Grammar,

Vocabulary, Reading)

Writing

Speaking

Stage 1

Stage 2

Stage 3

Stage 4

To apply a multilevel list
numbering:

> Select the text from Listening
to Stage 4 in the current
example.

> On the Home tab, in the
Paragraph group, click the
Multilevel List button. @

> Click the multilevel style you
want

> Select the text from Stage 1 to
Stage 4.

> On the Home tab, in the
Paragraph group, click
Increase Indent.

> Your multilevel list numbering
will be applied. @

Mars

The planet Mars is similar to
Earth in some ways.

Jupiter

Itis the biggest of all the
planets.

Saturn

It has a hot, solid inner core of
iron and rocky material.

Uranus

It was discovered in 1781 by
William Herschel. Unlike Jupiter
and Saturn, Uranus does not
seem to have an internal source
of heat.

Neptune
It was discovered in 1846 by two
astronomers, Adams and
Leverier. Its composition is
similar to that of Uranus.

Pluto

It was discovered in 1930 by the
Lowell Laboratory. It's no longer
considered to be a planet,
because of its small size.

Satellites

Charon

o (2 e
T @sen
World Oceans ke . 57 O contine trom prevous -
— e Adaoce s e numser
o f=
B Ao s
etk

~ The Michigan ECCE has these sectons:

3. aiaing

5 e E 5wt
B s B
1T s s nmno
B 42 sz
7 s pripowey
- s s prise]

To apply heading

> Select the word Mercury. @

> On the Home tab, in — e
the Styles group, click
Heading 1.© i

> Repeat these steps for all the
planets and Pluto, For the
words Satellites and
Charon, apply Heading 2. ©

Characteistics o each lanet

[« Jl

solorsystem.

Venus

K “eveningstr”inthe west

: carth
j onygen and e
Keep inmind that you can't IR R AR R R AR R R
add an automatic Table of Characteristics of each planet
Contents if you haven't
applied heading styles to Mercury
your document’s titles first.
solarsystem.
Venus

“evening tar” nthe west.

Earth

oxygen and nivogen.

Mars
The planet Mars s similr to Earth n some ways.

Jupiter
Itis thebiggest of al the lanets.

Saturn
thas.aht, solid iner core of ron and rocky materal

Uranus

seem to have an nternalsource of hst.

Neptune

simil to that of Uranus.

Pluto

Do you remember that you Ees ol

Satellites e
Charon

can apply a Heading from
the Outline view?

To create your own multilevel

list formats:

> On the Home tab, in the
Paragraph group, click the S
Multilevel List button. @ H =

> Click Define new Multilevel “The Michigan ECCE has these sections:
ist. T g e ||+ [
. 2. GVR (romma,Voabulory Resding)
> On the Define new ;=
Multilevel list window, o 4 Spesking o

make the changes you 1. stage s
want. K 4.2. Stage2
% 43, Stage3.
> Click OK. @ 5 . Staged
JPp— e a T
, Bl
A
s
:
[P Numberstyie for thisJ M
(S to choose the style H
Yo

With (T, you can

Use| to
choose the alignment you

¥

=

With EXIETREE, you can

i s

With 3, you i o e choose the number's

can set the bullet's ! = position alignment.
indentation. T =

A multilevel list is not

something that you
are going to use very The Michigan ECCE has these sections:
often, but it's a good U i
tool if you want to Tl GVR(Grammar, Vocabulary, Reading)
make a structured list, T wiiog
like the contents of ] N Seeeking
a book or project. B s
We.stage3
& .d.Stage df




Sample pages

Create anew document

The first step you have to do when using Scribus is
to set the size of the new document, depending on
the project that you want to create.

@ scivarsa

il e et e e Bt e |

Q. €§: e o |
o st

oo o

o @ MewDocument

To create a new documen

> Open the Scribus program.
> On the File tab, @ click New. ©
> On the New Document window, select A4. ©

> The new document will appear. @

@ Scrbur 154 Document 1]
B re ea en iowt e T Bm Vew Soow tinions Heb
o

€9/ 2/ 4CQANTIHBEAB 2 OP0E »lewiv

Bxa@L SC 00 NTER SN,
R L T

s 18 Q @ e ¢ 1 [8]1> ¥ (Wi 18 PO

n4

To modify the table cells:

> Select a cell. @

> On the Windows tab, @ select Properties. ©

> On the Table option, @ click the border @
and select Width, Type and Shade to style the
cell @

> Select Fill options to give color and shade to
the cells.

Colour Green_1
Shade:10%

Colour Green_1
Shade:100%

To modify the table te

> Select the text. @

> On the Windows tab, @ select Text
Properties.

> On the Columns & Text Distances tab, @ click
Vertical Alignment @ and select Middle. @

ryr

[0 e e men man e Tose ums vew sovur wiious web
OMBX&@) 5C X80 N TEHERAES /2

Stes
Tebie: o Stfe
cels: Nosuie
Borders

4[5 ptooted Une

e
ot sk B —
-
ot [ 5] s

apnus

Wy Text Properties

o
Om@xa@s dcx80 kTEGEG

¥

132

Documentsetup and preferences

After creating the new document, the next step is to setup some of its elements, like margins and save
options, in order for them to function automatically for the whole document. Also, you can set some other
preferences, like the language that you will use in your document, and some other guides (like placement
and visibility).

e [ S—
i c anguags WHe ot iem Iset Fae Tabe Extvas Vew Sopter Windoms Heb

10 v L] ol
> On the File tab, @ click g = s pIanaRL

P =
Preferences. @ o :

€0 /ps220
= -

> In the Preferences window,
click User Interface. ©

> On the Main Window
tab, @ select the language you

want.
> Click oK. @ »
ae
ana
@ preferences 7 X
Us: terface
ManVindow | StoryEdtor | itaacy | Swrttp
Appearance
T, 5 )
Theme: -
on et Sabus151

[ Use Small Widgets on Palettes
[0 se Tabs for Documents.

Recant Documents: [5 5

s
Meous: [t 3
Faletes: [6 pt B
‘E
i@smvm
s b4

To preview the fil

> On the View tab, @ select Preview and then click Preview Mode. @
> Now you can see the file, ready without Grids and Guides. @

[ pe—————

2 (9/ 9/ 4CAMTINEAE 7 D00 GEBD S im
D ST . e o

[ Cuantity | UnitPrice

BX&@L SCXMO A TEHEMXEO/ 2/ ACQAMTIH O

a 2]

ORDER

#Hands on!

What are the differences between a printed and a web form? Give
an example in which you would use a web form and a case where
you would use a printed form. Justify your choices.

115

133



Spreadsheets

Overview

1. Working with numbers
Rows and columns BINARY

Advanced formatting I CT

Simple calculations

Logical functions Spreadsheets
Create a chart

2. Analyzing data
Complex calculations
Functions
References
Advanced charts
Import and export data

3. Advanced spreadsheets
Tables and data
Advanced worksheets

binarylogic

4. Charts & Modeling
Charts and objects
Modeling and simulation
Options and views




Sample pages

TASK 2

Advanced formatting

So far, you've learned how to make a small table and TR Howeiinsmt S FNge e Foweiles s s~ ol
formatit to look nice. Now let's understand the meaning e —
of numbers and do some more formatting. Some issues Py Ug' TS
we'll look at are: What's the difference between a number nmw = ’;
and a currency? Can you put the date into a cell? = -
We will make a grocery list. We are going to type what we n % s A
want to buy from the supermarket, the quantity and how |1 | 35/09/2023
much each product costs. After that, we are going to 2 Grocery List
format it, but we will use advanced options. 3 |item Quantity Price Total
4wk 2 1
Currency 5 et 2 os
5 Orange juce 112
Let's start with the price. A typical use of Microsoft Excel |7 iapples 2 2
is to gather data that has to do with money. In such 8 potatoes 3 15
9 [Tomatoes 1 o8
0

cases, you need to change the numbers into a currency
format.

To apply a currency formaf
rrr——

> Select the cells you want e.g.
C4t0C9.Q

> On the Home tab, in
the Number group, from
the Number Format list, @
click Currency. ©

> The format of your cells has
changed.

Pageloyout Formuss Data Review View Hoep P

oo

sdenitc

A c
1| 25/09/2023
2 Grocery List
3 item Quantity Price  Total You can choose between
4 Milk 2 €100 Number, Currency,
5 Bread 2 €o0so Accounting and
6 Orange juice 1 €120 Percentage. Accounting
7 Apples 2 €200 aligns the values at the
8 Potatoes 3 €150 decimal point.
9 Tomatoes 1 €080
*Apples, potatoes and tomatoes are i kilos.
CONCATENATE

To join cell contents, you can use the CONCATENATE function.

To use the CONCATENATE functior
Home.

et Poge Layout Ota eiow View
> Click in cell €2. @ fo Ewsen Quoe  Euosmarnar | (1 0
> On the Formulas tab, in the Function phe E:’;f‘_ﬂ?‘“" iy g:::f_':w i
Library group, click Insert Function. € ey o
> In the Insert Function window, in the Or a - 5
select a category ist, click Al 5 ¢
> Click CONCATENATE. © ! Mountaln
B 8850
> Click OK. @ 3 e 8611
. 4 566 E
> In the Function Arguments window, in ES =
Text1 text box type A2, in Text2 text box & [ 5is
type “ *, in Text3 text box type B2, and in 7 [Coun s
Text4 text box type “m”. @ 8 [Date 06/03/2023
s
> Click OK. @
> Use the Fill handle @ to copy the nsetuncion T %
function. @

Searchfor s i

o seectacategory A1
Seecta foncio.

Type e descpion of what you war 1060 nd the ik G

-~ o_

Conromncenom
oo
= o v
CoNCATENA TRt e
3 s s g ot
o =
e o
e o ) C
ot ot s 1 Mountain
2 = |2 &
3l
4 [Kanchenjunga.
o - T | concaronarisa:sarm 5 [thotse
; = i & Makalu
1 Mowen 7 Count
2 [Mount Everest & [oate
3 a1 5
4 Nanchorjings 3 10] I ]
5 Thotse i
6 Makol 463 i
7 count s
o Date [
B
e I— |

Date

It's common to use dates in
Microsoft Excel. That's why the
program gives you a variety of
date formats to choose from,

a
To apply Date or Time:

> Select the cell that contains

1
2 Grocery List

‘The date must be in the format
that your computer s set:

mubs Qaty Review View Help O Seach

wo- | owe
B8 =% 9

the date you want to format, F = =5 soie
eg.ALO 2 i = s

> On the Home tab, in the oi’fﬁ_ e Z
Number group, click the [yl E Not all countries
Expand button. @ = o use the same date

> The Format Cells window
will appear. Click Date. ©

format. Some put

> In the Type list, @ click the
type you like and then click
oK. @

Quantity Price
2

€1.00,

the day before the

Merge cells, wrap text
and setalignment

The previous task was about how
you can format data. All of these
options are included in a single
window.

To merge cells, wrap

Keep Inmind that through the
Expand button you have more
options like custom text orientation.

the textand align it Flo Home i Pagelyout fomuss Owa eew View
BE | ks P B | e
> Select the cells you want to = B lvye il
merge, e.g. A2 to D2. @ il - i " e fic
> On the Home tab, in the 3 g
Number group, click the 5 5 7 5 L LA
Expand button. ] —
> In the Format Cells window, | s tit PPl W e e
click the Alignment tab. @ 4 Mik 2 of e
> Select the Wrap text © 2o 2 o:’ W o
range juice = m— b -
and Merge cells check e R i
boxes. @ 8 Potatoes 3 €1 e 3
> In the Horizontal list, click 2 Temstees 3 E"'“fo
Center and in the Vertical el | 9 foi
list, click Center again. @ 2 You canalso change
>Click OK. @ i the indentation or the
B | orientationof thetext. 1

3
|2 Grocery List
3 [item Quantity Price  Total
4 Mk €100
LEFT, RIGHT, MID

If you want to extract a part of a string (substring) use the LEFT, RIGHT
MID functions.

To use the MID functior

> Click in cell B10. @

> On the Formulas tab, in the Function
Library group, click Text. @

> In the list, click MID. ©

" ey
o B

Qren-

o0 3

s ine - Bvore i

and

fomuts Ows Revew View hep 1 Sesch|
Guompunieens: | (1 Gomerume -

Moo s o scion

> In the Function window, in
the Text box type. @ It's the cell from

which you are going to extract

characters

> In the Start_num text box, type. @
It's the position of the first character
you want to extract.

> In the Num chars text box, type . @

You are specifying how many i
characters you want to extract. L
> Click OK. @ il
N
> The result of the function is displayed —
in cell B10. @ MO
NUMBERVALUE
PROPER
ncton ruments i
o REPT
Tot .mo :J‘ e sk
a e o 2] -
- Similarly, you can use the
[ —— LEFT and RIGHT functions to
extract text from the left or
s 7 right of a text respectively.
P o]
o0 - -MIDA1049)
A B C
1 Mountain |
2 8850 Mount
3 K2 8611 K2 8611m
4 8586 jt 8!
5 Lhotse 8516 Lhotse 8516m
6 Makalu 8463 Makalu 8463m
7 Count 5
8 Date 06/03/2023
9




Spreadsheets

Sample pages

TASK 4

Advanced charts

Charttypes

To make your data presentations more lively and interesting, you can use charts. There are various charts

you can choose from, but it is essential to understand which type is the most effective for your purpose.

Bear in mind that choosing the wrong chart could lead to confusion or an incorrect interpretation of the
lata.

These are the main charts that you can create with your data in Microsoft Excel:

R UM Column or Bar Chart[ STE%']

between a series of data.Ina
iz

N
The (KEXEIT is used to display The [IZZXEETT is like a Line
trend: <

appear horizontally (X-axis) and data over a period of time. below the plotted line s filled in
i ith col
. Itis category and it s suitable for
charttypes. large number of groups. number of groups.

The SETIEAE Is used

overtime. Itis likea Line Chart,

Itis suitable The EITTTITIEL is used to
display dat:
- andis similar tothe Ple Chart.

/

only one series of data. It shows
pa

the whole.

(!
! ‘\\J
52
Printaspecificarea e — -

If you need to print out data that | [ E] @ e QRE (S Ce 2B @
is contained in a worksheet, but e | 2o 2 2| T B R
not all of it, you can use the P

Area option.

t

Type the following text:

To select the Print Area:

> Select cells from A2
toH9. @

> On the Page Layout tab, in
the Page Setup group, click
Print Area. ©

> Click Set Print Area. ©

e dome wen sageion o evew » s

2] Mo = 0
> Your print area is set. @ M’rmmw- Em@m jegt- .L_L.xa -y el
B = e Qe |0
A o sepiss St

e n

To deselect the Print Are: -

> On the Page Layout tab, in
the Pages Setup group,
click Print Area. @

> Click Clear Print Area. @

B 0B GEH B g we tur
(2" i stacil - et - H1- I [ g e

You canadd more
cellstothe already
existing print area.

68

To add a chart : s T ——_—
= e
> Type this table and select cells A2 to €10. @ o
> On the Insert tab, in the Charts group, click B o
? etotriion
Insert Column or Bar Chart. o
(ot i
> In the list of column chart sub-types, click the | o/Sansse

one you like
> The chart will be added to your worksheet. @

ann A

Modify achart
After you create a chart, you can
modify it. For instance, you may
want to change its titles or its.

type.

To move the chart:

> Click on the chart. @

> On the Chart Design tab in
the Location group, click
Move Chart.

> You can move your chart to
a new worksheet or

—
move your chart RS “‘o

to an existing g
wherever you want. © idobecoscd Bl omer 5
=
To change the Shape Fill of
the chart:
> Click on the shape you want iR | e

to make changes to. For
example select “Losses”. @
> On the Format tab, in the "
Shape Styles group, click
Shape Fill
> Click on a color of your s
choice.

; -;tnwr--:lksuwnmvwn=II|II

Background picture
You can also add a graphic as an image to the background of your cells. Keep in mind that the
background image should be very light in color, otherwise your data will be difficult to read.

To set a background picture:
B e b Dt o e

> On the Page Layout tab, in EHE- |0 & BRE
the Pages Setup group, T e | B P e e
dlick o = s

> In the Insert Picture
window, click From a file. @ Insert Pictures.

> Click the image you want to - — o T
insert and click Insert. @ [T for animage

You can delete
the background

> i b singimage seach 'ordownload one image by
The sele;lecll( imagedwwll be froimstive SGIRE dlicking|
g b irLO) P— using ST Backoround)

Freeze panes

In case you have too much data, you can use Freeze Panes to keep a row or
a column visible while you go to another area of your worksheet. For example,
let's say you want column A and rows T & 2 to be visible at all times.

= YR YT o

> Click cell B3. @ e = o = i 2. 2 i
> On the View tab, in the - 4] ne 8 SR,

Windows group, click
Freeze Panes.

> The first column and the
first two rows will be always
visible on your screen.

You have to

select

the row, cell or

ToFreezea: column that is

Column The first cell to the right of the column below or left of
Row The first cell of the row belon. e

want to freeze.

[ Row and column | The cell below the row and to the right of the column. |
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rowsand inachart

When creating a chart, the data can be grouped on the horizontal axis according to the rows or the columns.
S0 in our chart, on the horizontal axis, the data is grouped according to each student and we are going to
switch between the rows and columns to group the data according to the subject.

| To switch between rows and
columns in a chart:
> Click the chartyouwantto | o e ¢ o w1
switch data. @ el
> On the Design tab, in the 58 o» o owon
Data group, click Switch e
Koy I

i |

i - |

//Column. @ ® |

> The data in the chartis }
switched between the rows I
and columns. @ i

i 0 - [ K ;PJ; a8

s o st wy e

Using Quick Analysis

In a worksheet, you can analyze your data very easily and quickly. You can create
different types of charts, including line and column charts, or add sparklines. You

can also apply table styles, insert totals and apply conditional formatting.

To use Quick Analysis: a‘;“_. g e s
e Eaa wx |
> Select the cells that contain the data you === =, = e
want to analyze. @ N e 0 G
> Click the Quick Analysis button that A e
appears at the bottom right of your selected sy wow om W wm W o
> [, B ow o om om o omomo%
data. : © % o ow ow o om
B - S T -
> Click a tab you want. o 5ox oz s on oo
> Click the Formatting tab © to highlight T
parts of your data according to rules. TR | e
> Click the Charts @ tab to present your data al . |
in different charts. B - (
i preec’)
> Click Totals @ to select from various i | e sotr
formulas to apply to the rows and columns. ;; . I i
> Click Tables @ to filter and sort your data. S } | }
~ i
> Click Sparklines @ to use tiny charts in » e
single cells. z
88
e i e e e e
You can place an
want. To position an
object, click the object
M e e honls ke O ek W W D Teemamtioe (AR SwartArttiict
I — B[ ® @ P B booandthenwhen
- in | SIS T8 Bemacmn - | @-% 3 w5 | G 8w o] the pointer becomes
- o st d el P crossedarrows +}»,
s -] D drag the object tothe
A ) c o E location you want.
| _esep2s
2 [
5 ftem ouaniy Jprce
+ e
s [oresd
& [orange i
loples
o otators
5 [fomtoes
11 oples,potatoe and tomatoes e
2
"
u
1
i
1 [____Tropulation 2016 Tropulation 2022 |
anas on P o e —
[oermany Js1780000 Jazroceo |
" [62.770,000
Create the following table and the
corresponding chart: L
1. Search, find and insert Italy’s population in
your table for the years 2016 and 2022. Next, s00000m
‘add these new data series to your chart. T
2. Switch between the rows and columns to sy
group the data according to the population. ured
3. Insert an “Inverted Pyramid” SmartArt, where 40,000,000
you should sort the countries’ population of 2000000
2022 in descending order. st
100000
3

Chats  Towls  Tables  Sparklnes Eormatting  Charts

B B 8

g B h E i B E K

OnaBars Color.. leonSet Grester.. Top10%  Clear. Clstere.. Clstere. Stacked... Stacked... Clustre.. | Morew

Recommended Charts hep you visuaize daa

Towls  Tobles  Sparkines

Formating  Charts  Totals | Tobles  Sparkines Eomating  Chatts

BB B B B

Formulas automticay clcuae otas fo you. Tables

B B B B

Sum | Avenge Count %Total Ruming. Sum Table  PivotTable PivtTable PivotTable PivotTable  More

i you s, fiter,and summarize dota.

Touls | Tbies

Eormatting  Charts

Resizing charts = m =
and graphs Une  Coumn Wivtoss

You can resize a chart or graph in a worksheet in order
for it to have a better fit.

ines are min charts placed nsingle el

Towls  Tables  Sporkines

To resize a chart or graph: o=t £
A 8

c o
provuct_[janvary _rebruary_waaren | S
> Click the chart you want to JENE e S o -
resize and position your 3 Jshoes oI T vl .
mouse over any of the e == T
“handles” around it. @ - O | B O™ o
o
> Click, hold and drag your 7 S e
: ; s &
mouse until the chart is the 5 | £ I
desired size. 0 :
P 1
> You can use specific height
and width measurements, T R T T Frescr="

on the Format tab, in the - A-
Size group, type the Shape [ gw_:r A A A:s
Height and Shape Width in L I

the text boxes. €

> The chart has been
resized. ©

i

e

5 e

Computer models

Computers and modern software give us the opportunity to
analyze, understand and simulate real-world situations through
the use of models. A model can represent objects, conditions
and processes through the mathematical equations and rules
that define them. A spreadsheet can be used as a modeling
tool.

For example, a company could use a spreadsheet to find out
what would happen if they increased the price of their product
and the effect it would have on their income from sales. So, if
someone raises the value in the price column, the data in the
income from sales column will be automatically recalculated.

Simulation

When we input values into the model and get results, we
perform a simulation. The simulation is the implementation of
the model and shows how an object or a process will react
based on different input data or on variations in the rules of the
model

yday life
We use modeling and simulations for almost everything in our
lives. This allows people to test a system without having to
create the system in real life, to predict what might happen to a
system in the future and to train people to use a system without
putting them at risk.

Financial and business models

Financial models use mathematical equations to perform
financial analyses. These models are usually built in spreadsheet
programs for making recommendations and decisions. Also,
business models are used in the creation of predictions and
trends for forecasts and many other related uses to
manufacture comparisons.

There are many different types of
financial models such as:
Macroeconomic modeling

Stock exchange modeling
Marketing and sales forecasting

Investment modeling

Data

Modeling
& simulation

Refine
models

Prediction
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1. Image editing
Image essentials BINARY

ICT
Image adjustments

Retouch and enhance Graphic Design
2. Vector-based editing
Vector graphics
Coloring and shaping
Adding text and reshaping
Making curves
More design tools

3. Desktop publishing
From etching to DTP
Basic tools
Single-page design
Multi-page document |

binarylogic

Multi-page document Il
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TASK 3

Image adjustments

Photoshop allows you to adjust various aspects of your images
like the colors, the brightness or the contrast. Let's take a look
at how you can tweak those settings.

First of all, one quick thing you can do to any image s to try
out Photoshop’s auto adjustments. With an image open, click

o image from the menu and there they are: Auto Tone, Auto
R Contrast and Auto Color. Try them out to quickly correct
Ao Contst your images. If you don't like the result you can always undo
Auka Color by pressing B+

Image . AoCalel

If you are not happy with the
automatic results, there are a lot
of image adjustment tools that will
allow you to tweak your images to
your liking. Those tools can be
found under Image
>Adjustments. Let's take a look at
some of them.

cue
AreshieCutsd

oot
Lo Chibi
= CobrLoolu.
Dt
e
okt e
ot | et
by st SkcteColor
Exposure T e
Anabysis SEN Tonkge
This tool allows you to make your Vatons,

image brighter or darker. The
difference between exposure and
brightness is that exposure
brightens or darkens the whole
image equally whereas brightness
affects only the midtones thus
giving a milder result.

Sutacutet

o = sl / ‘Brghtness/Contrast =
oo Zhi Em_ ; Contrast oo = =]
LB e This tool is pretty basic and CEmo)
ome oo ) allows you to adjust the Sl £2 [
p— overall brightness and ]
— contrast of your images. Srimes/ By

Use the SEXFTRETY to selectively brighten
areas in your image as you paint over them.

Use the TINE to darken areasin your
image as you paint over them.

Use the SXTTFTRET to de-saturate (remove
color) certain areas of your image.

Fix lighting with Shadows

and Highlights
e au
Sometimes, parts of your images are too Mg Tane ot | (o cotana
o Cont ARuShRuColoL
dark or too bright, while you wanted a more hva o sntucuin | Prosee
balanced image. You can fix such problems = e | Lo i
with the Shadows and Highlights Cams 5. Arscuec | EE e
adjustment. g Rotiien Sy
Y‘ o Photo fier.
T Channl e
To use Shadows and Highlights: o Coisons!
ik Ivest. ot
> Click Image. @ s o
> Select Adjustments and then click Kot e
Shadows/Highlights. @ o
> In the window that appears, increase the b HOR Toning

Shadows slider @ to brighten the dark
areas of your image and the Highlights
slider @ to darken the bright ones. You
can preview your changes live,

> When done, click OK. @

> Take a look at the before @ and after. @ ":’:““"“
In this example, we chose to brighten
the shadows.

hadows gttt
snadows
et

Hue/Saturation

This tool allows you to change the colors of your
image (Hue), make the colors rich or dull (Saturation)
and lighten or darken colors (Lightness).

Replace Color
With this tool, you can select a color or a e —
;ol::hra:g;:nryoulr image and then replace e g —
another color. —_—
s 3
e -
To replace a color: -
- =

> Open an image. @

> Select Image >Adjustments >Replace
Color.

> With the Eyedropper Tool, click on the
color you want to replace on your
image. If you want to add or remove
colors to the selection click the + or
- picker button. Experiment a little bit. @

> Adjust the Fuzziness slider € to widen
or shorten the range of colors to
replace.

> Keep an eye on the mask window. @
The white areas are the colors that will
be replaces

> Adjust the Hue slider @ to change the
color of the selected areas.

> Click OK. @

Repsce Coor
Selecton
e =

4
o sohcen i

[

= =
I
swuraers Cm
e ML I
e o

Fix contrast and color problems with the Curves Tool

When your photos appear too hazy, lack contrast or the colors are off,there is no need to
worry. After a few quick steps with the Curves Tool you can get them to look just right

To use the Curves Tot

> Click the Curves icon @ from the Adjustments
panel to create a new Curves adjustment layer. ©

> Click Auto € in the Properties panel. This is a
quick one step fix. Check if you like the result. @

> Alternatively, you can try one of the Presets by
selecting one from the Preset drop-down list. @

> If you still think something is missing or you feel
creative, you can try playing around and tweaking
some points in the curve by hand.

#+*Hands on!

Now it's time to put your retouching skills to the test.
Take a look at this picture of a poppy field.

p:
php?image=9907&picture=poppy-field

Can you make it look like the picture on the right?

Tip: The image has been straightened, the power lines in
the upper-left corner have been removed with the
healing brush tool and the overall contrast has been
enhanced with the Curves tool.
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To create the sun:

> Draw a circle 40x40 and a polygon with 3
sides 15x10. @

> Align the triangle centrally and place it so
that its base is just inside the circumference of
the circle. @

> Move the gravity center of the triangle to the L1 o
center of the circle and rotate 5 copies by 60°.

> Select all the triangles and weld them with
the circle, having the Leave original target

object selected. @

> Right-click the triangles and select
Order >To Back Of Layer. @

> Apply a yellow color to both shapes. @

> Then select both of them and press (CZD+@
to group them.

Actually the Back of Layer command refers
to the object manager. As we mentioned,
you can use object manager to rearrange

your objects. Alternatively you can use the

Back/Front of Layer or

Lo Y vooevp W roceoomn )
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Fun Tools

Adobe lllustrator has some tools that can transform simple objects into complex ones
Some of them are easy to use, but some others need a ltle effort.

The Width tool helps you change the stroke width of an object. But, because it gives
you the possibility to change it into a node state just like Bezier, you can have different
widths in different areas in the same object

To use the Width tool

> Draw a simple object. @

> From the toolbox, select
the Width Tool. @

> Click the outline of the
object and slowly drag it
outwards.

> You can see that the
width i changing. @

> Now go to another area
of the same object and
drag again. @

> If you continue doing
this, you can create a
cool result. @

If you want to work
at a detailed level,
it would be better
to zoom into your
object.

y.alotof
if you know
difficult

82

In order to finish our card we
need to leam a new tool, which
is called PowerClip. PowerClip
allows us to put other objects
inside an object. These objects
keep their independence and we
can edit them separately.

To make a Power

> Right click the sun and ket
select PowerClip Inside. @ s
%
> Click the card. @ [
o,
> The sun is now inside the e

i

card.

> Double-click to move the
sun to the bottom left
corner and create a
duplicate in the top right
one. ©

> Click the small rectangle at
the bottom of the card and
that's it. @ Your card is
finished.

) 1 ’ i
#*Hands on!

Your birthday is coming. Why don't you create a
cool card to invite your friends!

The Warp tool is like liquify in Adobe Photoshop. It lets you bend paths
around to create new shapes.

To use the Warp to

> Draw a shape. @

> From the toolbox, click Warp
Tool D). ©

> Click on the edge of your
shape and drag your mouse
inwards. @

> See how the side of your
shape bent? @

> Repeat these steps on the
other sides as well. @

*Hl - )

The Twirl tool creates swirling distortions within an object.

To use the Twirl tool

> Draw a shape. @

> From the toolbox, click Twirl
Tool.

> Hold-click the bottom left
side of your shape for about
1t0 2 seconds. @

> See how your shape
changed? @

> Repeat these steps on the
other corners as well. @

As you have already figured out, allthese tools work in exactly the
same way. The only thing that changes is the result.
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To rearrange the panel:

> Click Swatches @ and
drag it over Stroke, a bit
below its center.

> Stroke and Swatches are
now in the same
workspace group. @

> From Window menu,
click Object & Layout, ©
open the Align and
Pathfinder panels. @
Click on their top bar @
and drag them over the
Text Wrap panel a bit
below its center. Now
they're all in the same
workspace group. @

> From Window menu,
click Styles, open the

Object Styles panel and
place it underneath all

the panels.

> Arrange your workspace
like in this image. @

To save your custom
workspace:

> Click the Workspace
direct menu button @

and select New
Workspace. @

Name it, eg. My
Workspace! © and click
OK. That's it! Your custom
workspace is set!

> In case you make
changes later on, go to ———
New Workspace once
more. From Name
drop-down list, select My
Workspace. © Click OK
and then confirm the
replacement of the
original workspace.

In case you made changes
you don't wish to save,

Notice that the text has a lot of empty space at the bottom of the last column, while at the same
time, it is aligned to the top of the image. We willtry to create a more balanced layout between
the three text frames.

To balance flowing text inside separate frame:

> Select and unlock the Text layer. Lock all
other layers.

> Use the Selection Tool (V) to select all three
text frames. A transform node appears at the
top-center of the selection. @

> Click this node and drag downwards until
just before the text gets "knocked out” of the
last frame. ©

Small letters over a picture are always a big problem. There are, though, some
ways to deal with it. Here is a rather “classic” one: placing white rectangle frames
behind each of the text frames.

To make a duplicate layer and [l prow—g
adjust its content
505 :

> Select Text layer, click the
layer menu button and click
Duplicate Layer “Text". @

> Lock Text layer and list the
Text copy layer under it. @

OdkeLoye Tot

LoerOpans o Te

> On the Text copy layer

e )

select all text (not the

frames) and delete it. @

> Select all three frames and

apply fill [Paper] and

stroke [Paper], 12pt. ©
> From Object menu, click
Corner Options © and
from the drop-down list

select Rounded, @ set
value to 8pt and click OK

> Much better, huh?

#Hands on!

1. Which are the materials that the builders used to construct each
one of the buildings presented in these photos?

2. Which are the tools and instruments needed for each construction?

3. Describe these constructions in terms of their aesthetic qualities.

Below on the left, we see a page from Marcus Pollio Vitruvius and on the right the RayGun
#69 issue designed by David Carson.

1. Find information about these designers on the internet.
2. What are the tools and equipment needed for each design?

3. Describe the aesthetic values that each one of these designs carries.

DECIMVS. 101

shis month the issue is black
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Basic settings
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2. Getting online
Surfing the Web
Use online resources
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Networking basics
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The main memory of the computer is

called RAM (Random Access. Apart from RAM, computers
Memory). RAM is used for the have other types of memory,
information (data) that is being like ROM or CPU cache
processed by the CPU. This data is memory. ROM is read-only
stored for a very short period of time. memory that stores data, but
The amount of memory is very Yyou cannot change it. CPU
important for a computer's cache memory is high speed

functionality and speed. Even if a memory that's inside the CPU
computer has a fast CPU, not having and deals with the most
enough RAM can slow all processes frequently used data.
down,

Video Card

The Hard Disk Drive (HDD) is the main storage device of your computer. You
use it to store and retrieve information. All the programs, including the
operating system, and all the files that you have created by yourself or copied
from other devices are stored inside the hard disk drive. The main
characteristic of a hard disk drive is that it can hold a lot of information. Its
storage size, as we say in computer language, is very big. Nowadays, a single
hard disk drive can be up to 20TB. It can hold 20,000 movies and millions of
songs, pictures and documents.

The Video Card (graphics card or
display adapter) turns the data that is
processed by the CPU into images on
the monitor. The better the video card,
the better the quality of the images.
This is especially evident in computer
games. Modern video cards are like
small computers, and they have their
own CPU and fast memory, in order to
offload the main CPU.

Sometimes, the video card is
integrated into the
motherboard. If you don’t
especially need a powerful

video card for gaming or
video editing, a computer
with an integrated video

card will cost you less money.

Shortcuts

Sometimes you may need to work on a file or use a program very often and you don't want to waste
time looking for it every time you want to use it. That's why we create shortcuts.

A shortcut s a “link” to a folder, file or program. If there’s a file or program you use very often, you can
create a shortcut that takes you directly there. Let's see how you can do it

To create a shortcut

> Open the location of the
item you want to create
a shortcut to.

> Right-click it and lick
Create shortcut. @

> A shortcut will be created in
the same location as
the original item. ©

> Move the shortcut to
a new location using your
mouse (drag and drop
the icon).

To create a shortcut directly =2
on the Deskto o

> Right-click the file you want
to create a shortcut to
and point to Send to.

> Click Desktop (create
shortcut) © and a shortcut
will be created on the
desktop.

3

When you right-click a shortcut, you can see a list of
options. One of them is the option Delete. Click it and you
will delete the shortcut you have created. But remember:
when you delete a shortcut, only the shortcut disappears.
The original file, folder or program is ot deleted.

icons onthe v butthere aren’t
y ! onthe and icons
onto the Taskbar. Taskbar, just

Peripheral devices

Peripheral devices are devices that are connected to a computer, but they are not part of it. In
other words, they extend the computer's capabilities, but they are not necessary for a computer to
function. These devices are divided into 4 categories: input devices, output devices, input/output
devices and storage devices,

Input Devices

Input devices are devices that help the user input data, such as
text, photos, songs and movies, or control the computer.

The keyboard is one of the main input devices.
Through the keyboard, the user can input text and

give commands to a computer. Its ke a

typewiter, but you type on screen and not on

paper.

The mouse is a pointing device that helps the user point to objects

on the screen and execute commands by clicking on them. A typical
mouse has two main buttons, but modern mice have more buttons

that help you execute frequently used commands with one lick.

A gamepad is a game controller that helps you give commands and
move on the screen. If you play video games, you already know it
Usually, a gamepad has a cross pad or a controller stick and some
action buttons.

Amicrophone helps you record your
Voice, save it in digital form and then
make changes with audio editing

RLBOIPTS: Gamepads have evolved in
The Surface Dial is a brand recent years. Some are wireless,
new kind of peripheral that like Nintendo's Wii controller,
serves as a tool for the creative which allows you to control
process. A surface Dial your player through a stick. If
optimizes your digital work by you want to play a game that
bringing the most used Kinect 2019 was designed involves a racket, you wave
shortuts and tools directly to by Microsoft to be used as your controller as if it were a
your screen by simply pressing @ sensor with a lot of real racket. But there are also
and rotating the Dial. capabilities. controllers like Microsoft

Kinect, which allow you to

interact with the game console

or computer without holding or
touching anything. Microsoft
Kinect works by “watching”
your body movements and

“listening” to your oral
commands.

A

Compressed files or folders

Sometimes files or folders take up too much space on your computer and you may want
to make them smaller. A compressed file takes up less storage space and you can easily 9
copy it to another computer or send it by email. Compressed files or folders can be

copied and moved as files. You can also use them as a folder. You can add more files to
them or you can delete files from them.

To compress (zip) a file or =
folder: .

> Find the file or the folder o :
that you want to compress,
right-click it @ and point to
Send to.

> Click Compressed (zipped)
folder. ®

Mytoider

> A new compressed file is
created in the same
location and has the same
name. Big- e [—.
[ [ ————

© o v B > T > Docmms MOIEE
To rename a compressed
folder: #+ Quckscen [

@ oncvie

> Right-click it and click

S b
3 0 0bjas

> TEEea new name and press = oy

Another way to rename a

file is to select the file and
press @ on your keyboard.

If you double-click the compressed folder to open i,
you will see a detailed view of how the size of the files have
changed. In this example, the original file was 41KB and
became only 36KB after the compression.

—

T PC > Documents » My folder > Myfolder o Serch My flder
A Nome e Compressedsize P
& animas Microoft ord Document %K@ s 1%

The amount of

thefile type. For

you won'
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MODULE 2

Getting onli

ne

It's time to explore one of the modern wonders, the Internet. We'll find out

what it is, how it came into our lives and
how we can use it to gather information

why it is so important. Let's find out
and communicate with our friends.

We'll talk about what tools we can use and how to use them. You will see that

there is more to the Internet than you cal
our lives easier. One of the Internet tools
email. We'll discover why so many peopl
communicate with our friends through i

Learning Objectives

In this module you will learn:

> what the Internet is.

> how to use it to gather
information.

> how you can expand your
knowledge through the Internet.

> how to send an email to your
friends.

> how to send photos and other files
to your friends.

> how to send the same message to
more than one user.

> the safety rules for the Internet
and email.

Toinsert a video from o
YouTube in your post:
© [ Bogeer

> On the Toolbar, click the
Insert video button. @

> From the drop down menu,
click Youtube. @

> In the Add a Video
window, click the Search
tab, © type your search
query in the search
box @ and click the
Search button. ©

> Choose the video you
want @ and click Select. @

> The video is added to your
post. @

Exercise

you don'tget il easly?

Gt atleast.

rsasvieeo

To remove a video,
Just click it and press
[ eiete §

B T

i o

n imagine and learn how it can make
that we are going to explore is
e use it and how we can

 Skills |

After this module you will be able to:
> use a web browser.

> search the Web for information.

> use wikis.

> copy a text or an image from the
Internet.

> create a new email message.
reply through email.

> forward an email message.

> attach a file.

> create a photo album.

> check your messages for mistakes

> Outlook

> Google Gmail

> Outlook.com

> Apple Mail

> Google Android Mail

Exercising s very important. It keeps your heart healthy and

Exerciseforat least one hour evry day.
Don' it front ofthe TV formore than o hours a day -
.

ot |+
€ 5 O | B hps/mwboggecoms
< [ Bogger

Heathy habisfor heathy ks

/o e Bomowmi 81
Exercise

Exercising is very important. It keeps your heart healthy and

‘you don't get ill e

* Exercise for at least one hour every day.
* Dontsit in front of the TV for more than two hours a day.
© Getatleast eight hours of sleep every day. v

TASK 1

Surfing the Web

Internet... a word that dominates most computer-related conversations. For good reason, too: Since its
appearance in the 90s, it has become an integral part of our lives.

But what exactly is the Internet? It's a global network of millions of computers that exchange information. It's
the largest computer network today and it connects thousands of private, governmental and academic
networks. On the Internet, you can find a huge amount of information, photos, videos and music. What's
more, you can call your friends, send emails, instant messages, etc.

How do I get online?
Accessing the Internet is very easy
and anyone can do it. First, you need
to have a computer that can connect
toa network either with a cable or a
wireless connection. Then you need
to have a phone line. Don't forget
the router: the networking device
that will connect your computer with
the phone line. And finally, you also
need an ISP (Internet Service
Provider) that will provide you with
access to the Internet.

An ISP (Internet Service
Provider) is the
telecommunications company
that will provide you with
«access to the Internet.

You can connect a computer, a
smartphone, a “smart” TV or
even a car to the Internet.

49
Publish your post
After you finish writing and editing your post, you are rezdy to publish it. Before that, you can
choose the Preview option to check what your post will look like and decide if you want to make
some final changes before publishing it
To publish your post © 0 soger
> From the main window, click | memyssarmsnycs
the Publish button. @ Selmn B -ty
> In the Publish post? Eat right -
window, click CONFIRM. @ ‘our body needs vitamins. Vitamins keep your bads heaihy!
> In the main page, click the Bt of it ad et pusisn post
i Dot et sven s o wtr ey
> The post will be published o
into your blog.
PR )
— i et ot e ¥
« Heaithy Habits { 4 ) -
[ —— <
Eatright
Your by needs vitanin. Vitamins keep yourbody healty!
atlotsof i and veoetab
Dt leastseven gasses o wote every d
Dorteata o ik many fzy
InPreview mode, you
can choose to see how
Ow the post willlook ona
I screenorona
— SIS screen.
| © © sogger °
0 mogoe
[——
st babts for sty i <
34 viamins. Vitamins eep your bodyheathyl
{ frt snd vegetables
Bas!scven gassesof wate every
Eatright o o1 sweets or ok many 22y ks
Vi oep your bod sty
%9
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Receiving files

All media files sent by your contacts are automatically saved in your WhatsApp
Media folder that was automatically created on your phone when WhatsApp was
installed. You can access these files from your phone’s photo gallery or from the
application.

To access an image file:

> In the Home screen of your phone,
tap Photos. @

> You can access your files through the
WhatsApp Images folder. €@

ovidns

View contct Be careful when you accept
a file, because it may

edi, ks, and o
sselivnboisiconi contain viruses that can

Search ‘harm your device. It is

recommended that you
Mutepotficatons never accept files from
Wik people that you don't know.
Vore .

< LisaCooper

You canaccess _— fooes
thesefilesfrom [ |
‘your phone’s RECENT

photo gallery
orfromthe
application.
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TASK 4

Notes management

Microsoft OneNote is a digital notebook that provides a single
place where you can gather all of your notes and information. It
also has the added benefit of powerful search capabilities to
quickly find what you are looking for. OneNote offers the
flexibility to gather and organize text, pictures, digital
handwriting, audio and video recordings, and more - all in one
digital notebook on your computer. Furthermore, powerful
search capabilities can help you locate information from text
within pictures or from spoken words in audio and video
recordings.

So, let's see how your notes are organized in OneNote. It's very
easy to get the hang of it when you think of it as one of your
school notebooks. Different notebooks appear as a list on the
main OneNote window. Each notebook has sections which
appear as tabs at the top. Finally, each section consists of pages
which appear on the right with their titles.

To create a new notebool

> At the top left of your screen, click Notebooks. @

> From the drop-down list, click Add Notebook. @

> In the New Notebook window, click This Pc. ©

> Type a Notebook Name @ and then click Create Notebook. @

e T T o
: ’ .
e —_—
—— . i
by epan et
© oseron e

e
New Notebook
o B hisec
Neabook ane
@ O -Pesonl )y
e €@ =
D ritsie R
5 sowse
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Voice and video call
WhatsApp offers you the
opportunity to call a friend and
talk in the same way you would on
a telephone, but free of charge.
You can also make a video call if
you and your friend have a
camera, and see each other while
talking.

To make a call

> Select the contact you
want to call and tap the
Callicon. @

> In the Start voice call
window, tap CALL.

> The call is established
once itis accepted by your
friend. ©

Startvoice call

CANCEL  CALL

Lisa Cc

To make a video cal

> Select the contact you want
to call and tap the
Video Call icon. @

> In the Start video call
window, tap CALL.

> The call i established
once it is accepted by your
friend.

Start video call?

canceL  caLL

17

Add sections and pages
Once you create a new notebook, you can add as many sections as you want. Each section can
contain a collection of related pages where you can write down your notes.

To rename a section of your notebook

> Right-click the section tab you wish to
rename.

> Click Rename @ and type the new
section name.

> Press or click anywhere else
and the name changes. @

OneNote automatically and
continuously saves your work while
you make notes. It also saves your

work whenever you switch to another
Ppage or section and whenever you
close sections and notebooks.

. « [E— D oy Academy 84
To create a new section:
Fle Home et Oraw History Review

> Click the Create a New Section tab, at | cuprivgn - 20 - B I s -
the top of your screen. @
> Type a name for your new section and B Wiy ook | Newsaont || 4

press GIEED. ©

> The new section has been created. @

Mo dame O ooy Rmie Vi e

g - o B I b A2 iE

B sy
B

To insert a new page:

> Open the notebook or dlick the section
where you want to insert a page. @

> Click the Add Page button. @

> Type a title for the page. @

> A new page has been inserted into the
section.

¥ page

can change. the order within the section.
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Presentations

Overview

1. Presenting your ideas
Slides, text and images BINARY
Transitions and animations I CT
Sound, video and 3D models

Charts and graphs Presentations
Tips and tricks

2. Multimedia presentations
Storyboarding
Capture and edit multimedia
Record your voice
Fix photos and add effects
Create an animated story

3. Advanced imaging
Image essentials
Layers
Image adjustments
Retouch and enhance
2D animation creation

binarylogic
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Start typing

Now it's time to create a small presentation about a campus
cafeteria. Let's find out how you can type text onto a slide.

:

> Click the text box which ek
says Click to add a title —
and type your text, e.g.
Our café. ©

> Click the text box which
says Click to add subtitle
and type Business plan. ©

When you see an object with
this outline and dots, it means
that you can resize or rotate it. ‘

You can do thisinall Microsoft

Howtoinsertaslide I

To give your presentation, you o
need more slides.

Toinsert a slid

> On the Home tab, in
the Slides group, click New
Slide. @

> A new slide will appear
below the first one. @

e
@ Our café
Click to add subitle. 1
Ourc«café a

Businesplan o

B Click to add title
~Clekto sdd text

B St sences s

You can jump from # you click the [IIEIE
oone slide to another arrow, a list with different
[l styles of
pane. cl y
raising ti etc.

3DModels

A 3D model s a three-dimensional view of an object or picture which you can insert into your
presentation to illustrate a point. You can add a 3D model from  file on your computer or from

online sources.

Toinsert a 3D model e o e

Soerams

> Click the slide of your s 8 Brs
presentation to which you
want to add a 3D model. @ aYa

> On the Insert tab, in the
Hllustrations group, click
3D Models @ and from the
drop-down list, click
From Online Sources. ©

> In the Online 3D Models

oy

Qi -

The magic

B S B (| @
g o L8 it 0t | s - | 2

Run a cafeteria for students operated by s
+ Knowledge — we know what students lik
* Hard work - we have to satisfy our class

window, choose a
category @ and find a Onine 30 Models

model that you like. @

> Click Insert. @

> The 3D model will be
insereted into the slide. @

Using 3D models in Instead of
PowerPoint, you enhance

your presentation by adding
depth, realism, and
interactivity to your content.
enteringa
keyword.

Run a cafeteria for students opr *ed by students
« Knowledge - we know what ents like

* Hard work - we have to satis __ur classmates
l - + Expertise - with time... )

Insertimages

Now it's time to see how you can
add an image to your presentation.
First, type your slide title.

To add an imag; A
If you click the

> Click the Online Pictures b G icon, you can
icon in the center of the insertan image from
slide. @ your computer.

> In the Online Pictures
window, type a keyword or
phrase in the search box
and press Enter. @

> Select one of the images ©
and click Insert. @

> The image you chose will be
automatically inserted in
your slide. ©

* Click to add text

Microsoft PowerPoint
will display some ideas
on the right to design
your presentation.

Ourlogo

=] Remember that on
g the Home and Insert
. tabs, you can
format and insert
¢ objects just like in
- Microsoft Word.

Scrollthroughthe
suggestions in the BT
[EXEE pane and select the
design you want.

Once you have inserted a 3D model into your presentation, you can modify it by rotating it,
tilting it up and down or by choosing a preset view. This enables you to highlight specific
features or aspects of this object in your presentation.

To modify a 3D model:

> Right click the 30 model

and then click Views. @ e _N:“M Pk -
> Choose the view that you

prefer to show the 30

model. @ The m v:
> Drag the 3D model to o

position it in the place you Run a cafeteria for students opr  * &

PEie: O + Knowledge - we know what

* Hard work — we have to satis

The magic Expertise — with time... s

entsopr @

w what
to satis

The magic

Run a cafeteria for students operated by students
+ Knowledge — we know what students like

* Hard work - we have to satisfy our classmates
* Expertise - with time... ©

You canalsorotate
the 3D model if you

don'tfindaview
that you like.

£ Hands on!

After this lesson, you can start creating a real presentation.
Search the Web for videos, audio and 3D models that you
like to put in your presentation. Don't use long videos,
because the audience might get bored.
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MODULE 2

presentations

In this module, you are going to explore the magic of movies
and pictures. You will learn how to create an animated story or
a short movie step-by-step. You will learn what directors do
before they start filming and how they use sounds and voices
in their movies. You will learn how to combine multimedia
material into a movie and how you can publish your work on
the Internet for your family and friends to see.

Learning Objectives

In this module you will learn: > Audacity

> what script, découpage and > Photos
storyboard are. > Clipchamp

> what you need to do before you start > WavePad
shooting a movie. > Adobe PS Express

> the various types of media files for e via
the Internet and your computer.

> how to record your voice.

> how to work with music and sounds.

> how to edit photos that you take.

> how to create a short animated story
or movie.

 Skills |

After this module you will be able to:
> create your own script.
> use different types of media files for
specific purposes.
copy your video clips onto your
computer.
edit sound and apply effects.
edit photos or other images and
correct them.
use a video editing program to create
a movi

It's time to write your script!

Aseript has three important components: heroes, action and dialogue. The “action” is written in the
present tense and is a description of what is happening at a particular moment or what your characters
are doing. The “dialogue” is all the things your characters say. The “heroes” are the main characters of
your movie. For example, a very small part of a script, containing both action and dialogue, could be
Something like this:

Scene 1: People are inside the classroom. It is sunny outside and light is coming
in through the window. All the students are in the classroom paying attention.
Mike leans towards his desk mate Jim and whispers:

- Have you done yesterday's homework?

One more thing you need to know is that in a script, the story is divided into
scenes.

A scene s the action happening in a specific place at a specific time. For
example, when you are in the classroom during a lesson, this could be the
“lesson scene” but when the bell rings and you go out to recess, the scene
changes because the location has now changed.

You don’t have to write every detail about the
environment where the scene is taking place.
This is a job for the director. He has the final
word, after he discusses all the details with
the rest of the crew (director of photography,
sound engineer, set designer, etc.).

Découpage

Once you have your script, the next stage is to plan how your scenes are going to look in more detail
This is called découpage. In découpage, you break every scene down into “shots". A shot starts from
the time you press the record button on the camera and ends when you press it again to stop
recording. As you can imagine, a scene typically consists of multiple shots, but sometimes a director
can choose to shoot a whole scene in a single shot, without stopping and relocating the camera.

So, you break your scenes down into shots and you also plan and write down how each shot is going
to be. For example, for each shot, you note down how far or close the camera i going to be to each
character, the angle of the camera, eg. if it is going to be somewhere high, looking down on the
character, the movement of the camera and details about what we see and hear in each shot.

When you are typing or writing for many hours, take a
i rists or

you might suffer from CTS (Carpal Tunnel Syndrome).

a4

TASK 1

Storyboarding

You have all seen movies at the movie theater and some of you may have made
your own home movies of family vacations, celebrations, etc. You may have
noticed that these home movies usually have some things in common:

> The image is shaking in all possible directions.
> The shots are either long and boring or very short.

The angle of the camera is rarely anything but the
cameraman’s shoulder height (which is also boring).

and so on.

Well, it doesn't have to be like this! As a matter of fact, every video you make
and even your other media creations can be made to look a lot better if you take
the time to plan some things first.

OK, 50 let’s see how the professionals do it, to get some nspiration and maybe
to borrow some of their tools to help plan our own creations.

OOOO

TheScript

For the first part of your plan, you need to answer two very important
questions:

What am | going to talk about?
What is my movie about?

Remember, it doesn't have to be a masterpiece just yet! Even a simple
movie about you and your classmates on a regular day at school is a very
good idea for your first, carefully planned movie

OK then, as soon as you have the main idea, its time for the story.

What exactly do you want to say in your movie about a day at your school?

Thefirst

Storyboard

For the final part of your film planning, you are going to create your movie's storyboard. Don't worry,
though; it's not that difficult, although it does require some drawing skills. The storyboard is like a
comic of your whole movie. You have already done most of the work during découpage. Now, you are
just going to draw what each shot should look like.

Essentially, you put all the details you have written for each shot into a picture. You can also include
arrows or instructions that indicate movement.

Once you finish your storyboard, you are done with all the hard work. You can now go out and shoot
your movie. It wil be easy, if you have planned it carefully and follow your storyboard.

Enjoy your movie making!

#Hands on!

Think of a short story you want to tell.
Write the script for that story (remember to divide your story into scenes).

Imagine your story on the screen, draw a detailed storyboard for each shot of your movie
and present it in class.

Remember: Your storyboard drawing doesn't need to be a masterpiece. If you can't draw
well, you can just use stick figures for your characters and simple scribbling for a
background.



Sample pages

Lens correction

Sometimes our cameras distort our pictures. Have you noticed
that sometimes when we photograph a tall building and tilt our
camera upwards in order for it to fit in our frame, the building
then appears as if it leans backwards or as i it is smaller at the
top? This is a common problem called perspective distortion
caused by the lens of the camera but we can correct it in GIMP
along with other common distortion problems. There is an
example of this problem in the picture to the right.

correct lens distortions:

may leave transparent areas
> Click Filters. @ % i

at the edges of your image.

Note that the Lens Distortion Tool

Perspective and
Crop Tool

> Amuch easier and faster way to
correct images that suffer only
from perspective distortion is to
use the Perspective Tool.

To correct an image
with the Perspective Tool

> Click Transform Tools @
from Tools.

> Select Perspective from

Tools Fiters

Selection Too
Paint
Tanst

i path

A Ted

G oL

# Colorpicker
A Messure

Q zoom

Toolbox

G Defaut Colo

—

ansform
Unifed Tonstorm

Handle Tansform

> Click Distorts @ and then Lens Distortion. ©
> The Lens Distortion window appears. @

> After making the adjustments that suit your needs
click OK. ©

You may want to crop these

out and keep only the important

parts of your picture. Take a look
at the final result.

102
The next step is to add some colors. Select the Fill tool and select a color from the Colors panel.
You can either pick one of the preset colors or click the black square to open a color picker window.
2
')
A | |
Importhand-drawn sketches B —
If you feel more comfortable drawing sketches on real
paper, you might want to import existing drawings using > Click File. @
Pencil. You can import a bitmap image to a particular N e Import s e mee ©|
frame in a bitmap layer.
> Browse to the location of the image
(or images) and select it. @
PGt Vi o o Uy Vit il = Sk . O
o aun
o o o
Openhict . T
s cus £ ks 10| [ 5 st
B s i
O Nt Ja
[y —
(ol== @ ouone
By 3 noses
e Wowen
e .
i pee
= et
-
= 2 el
o | [ oma
Alternatively, you can drag and drop bitmap images from an external
window onto the canvas. A key is created for each imported image.
This is particularly useful when you have a lot of images.
116

op Golor

Transform Tools. @

> Drag the comer handles so
that the horizontal and

vertical lines of the grid
align with the respective
lines of your subject. In this
case, with the edges of the
building. ©

> Click Transform. ©

> Select the Crop tool @ from
the toolbox and crop out
the unwanted areas

> Press (XX to crop. Now
your image has corrected
perspective. @

id ye

Use aCameraLayer

A Camera Layer lets you define a particular view,
with a certain aspect ratio, within your unlimited
canvas. What's more, you can define a view for each
key of the camera track, for example, move your
character in one direction. To do so, simply create a
camera layer, move the red scrub to the desired
frame and use the hand tool to adjust the view
inside the camera viewing frame. By double-clicking
on the camera name, you can set the resolution of
the camera viewing frame.

Exportyour
You can export your animation as a sequence of PNG images. Note that the current view is used for the
export, ie. either the working view or the camera view if a camera layer is selected

To export an animation:

> Click File, @ point to Export @ and then click
Image Sequence. ©

> Browse to the location you want to save the
images. @

> Type a name for your image sequence. @

> Click Save. @

> Set a resolution, or leave it if you have already
set it in a camera layer.

> Click OK. @

Fie| €6t View Animaton Took Lyyer Windows Help
New

It's time to practice your skills as an animator! Use Pencil to create a short animated
cartoon and show it to your classmates. Don't worry if your drawing skills are not that
great. If so, compensate with a cool storyline and just use basic shapes or stick figures for
your characters.

103
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binarylogic
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Computer science basics

Welcome! In this module, you are going to learn how a computer really
works. We will discuss its architecture and how it stores and processes data.
We will also explore how networks work and how computers have changed
the way we live and work.

| Learning Objectives S Skills

In this module you will learn: After this module you will be able to:

TASK 1

Data manipulation

Modern digital computers can be found practically anywhere around us nowadays.
We have desktop computers at home, at school and at work, powerful laptops tha
are easily transported from place to place and even smartphones, which are fully
fledged computers that we can carry around in our pockets.

Decimal system - Binary system

Since computers run on electricity, all of the internal components can only “understand” two

> how data is represented in a
computer system.

> how data is stored and processed
by a computer.
how computers can make decisions
with Boolean logic.
how computers manage memory,
processes and files.
how networks transfer data.
why online privacy is very
important.
how technology affects modern
life and society.

> how the digital divide affects
different factors.

understand the binary and
hexadecimal numeral systems.
convert numbers between the
different numeral systems.
understand how logic gates work.
understand why we need the
operating system.

enable a network firewall.

use technology for personal and
social benefit.

> Microsoft Windows

states: they are either in a low-voltage state or in a high-voltage state. All modem
computers are what we call binary machines. This means that the ‘language” that they use
internally in order to function is the binary numeral system, which is a way to write numbers
using only two digits: 0 (low-voltage state) and 1 (high-voltage state).

By using a series of 0s and 1s, we can create all the other numbers. In the decimal system,
which people normally use, each digit can take one of ten values (0-9). When digits are put
together to form a number, the place of each digit has a different place value, increasing by
a power of ten.

To represent the number 131 in the decimal system:

29501
105 =100 | 10' =10 / o \

1x100 +  [3x10 + \1;17 B0+ 102 102 100 109

The same principle is used in the binary system. The difference s that, each digit can take one of
two values (0, 1) and each place value increases by a power of two (ones, twos, fours, eights.etc).

Place value

131, for example, is 10000011 in the binary system:

1 0 0 0 0 1 1
ORI 27 =128 | 2°=64 |2°=32 2'=16 | 2° = 2'=2 2 =1
1x128 0x64 + |0x32 + |0x16 + [0x8 + [0x4 + 1x2 + 1x1 = 131
+
Notice that the place value of the rightmost digit in either system is 1.
Any number (except zero) to the zero power equals one. O I O O l
Consequently, 10°=2°=1
You can now read and understand any number in the binary system! / \ \ \

In computers, the basic unit of information is

calledabitand it can either be O or 1. The word
comes from a contraction of “binary digit”.

Monitor color

To store images, we need to represent the color of each pixel in an image. The most common
way is to use the RGB model in which each color is the sum of the different shades of the three
primary colors (Red, Green and Blue). So, for each pixel we actually store three values, one for
each color, each ranging from 0 to 255 which indicates the shade of each color from black to
pure red for example. Thus, an image is the binary representation of three colors that make up
the pixels of the picture.

Monitor color analysis

R G
- 1

Red

Green 255 0
Blue “n 255
Video is the most complex data
type to represent but generally it
Cyan 255 255 can be thought of as a series of

images, saved in binary and played
back one after the other. These
images are usually compressed in
order to save storage space and
process the images as fast as
possible.

Magenta riy “ 255
o [N

Boolean logic and logic gates
The data is in binary format, but computers have to convert the data for it to do something
useful,

Boolean logic, named after its creator, mathematician George Boole, provides us with a set of
operators that do simple transformations and comparisons of data. Just like in decimal
arithmetic that humans use, where we have operations like addition, subtraction, multiplication
and division, in Boolean logic, we have NOT, AND, OR and XOR. With these simple operators,
we can build complex systems, as complex as a computer CPU!

In computers, each basic Boolean operation is implemented by a logic gate, which is a device
that accepts one or more input signals and produces a single output signal.

Each gate is associated with what i called a truth table. A truth table shows all possible input
values and the corresponding output values for a specific gate.

Let's get to know the Boolean operators and the corresponding logic gates.

LogicGate (1

ANOT gate accepts one input value and produces one output value. The NOT operator inverts the
input. If the input is 0, the output is 1 and if itis 1, the output is 0.

Input Output
A NOTA A
) 1 Input Output
1 0

LogicGate[,
An AND gate accepts two input values, which both determine the output. If the two input values are
both 1, the output is 1; otherwise, the output is 0.

Input Output A
A B AAND B
0 0 0
o 7 Input Output
7 0 0 pu—
1 1 1 s

LogicGate[*];]

Like the AND gate, an OR gate has two inputs. If the two input values are both 0, the output value
is 0; otherwise, the output is

Input Output A
A B AORB
0 0 0
0 7 1 Input Output
1 0 1
1 1 1 s
LogicGate,(*];]

An XOR, or exclusive OR, gate produces 0 if both inputs are the same, and 1 if they are different.

Input Output

A
AXORB
‘1’ Input Output
s

A
0
0
1
1

~|o|-|o|w

o

searches? Using the NOT operator (-) you can exclude results that
hi

rd. For [ speed
~car P

Al your

want the results to contain all the words of your query.
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Life-long learning

Life-long leaming is the process of gaining knowledge and skills throughout your life,

often to help you do your job properly.

> Lifelong learning requires self-motivation. You must feel good about learning and
your ability to learn.

> Effective leaming requires that you obtain information through reading, listening,
observing, practice and experience. Information is all around you, so you should strive
to obtain relevant and meaningful information, and develop this into knowledge and
skills.

> Learning is successful when we find personal meaning in the information we gain.

> You can take notes and practice, discuss and try new ideas and skills to help you learn
and develop.

> You have to think about your own learning. Think about how and why you leam,
including how you feel about a specific topic or situation before and after developing
your knowledge.

> You should check your knowledge regularly to help reinforce what you have leamed
in your mind. You should always try to maintain an open mind, question your
knowledge and be ready to consider new information.

I —

The great development in technology has provided an important drive
to adopt new payment methods on the Internet, and these methods
have become comfortable and easy to use. For example, consumers

can use the new payment methods in many applications to pay
purchase costs, such as Alipay and WeChat.

50 we must be ready to accept new payment methods soon.

As for cryptocurrencies such as Bitcoin, it is still not clear whether
these currencies will affect electronic payment methods in the near
future due to many lawsuits and legal restrictions around the world,

allow faster processing for financial operations.

Cloud storage

Cloud storage services allow us to keep backup copies of our files

online and access everything from anywhere with just an Internet =
connection. One might think that since we are not sharing anything or =
making our content publicly available, then our privacy s secured. ==

While this might be true in most cases, you should never forget that
you essentially entrust private companies with your personal files. They
Say that they won't violate your privacy by looking at your files, but if
they want, they can, so it is a matter of trust. Also, you should be
aware that many major providers of cloud storage automatically scan
your files to detect legal content like songs or movies downloaded
from the Interet and remove it or notify the authorities. So,
concerning cloud storage, avoid uploading extremely sensitive
personal information and always keep a copy of your fles in a physical
hard disk drive at home.

The e-wallets supported by such applications are constantly evolving,

however it is certain that the technology used in those currencies can

Textgeneration

ChatGPT is an example of an open-source language generation model developed by OpenAl. It
i part of a larger category of Al technologies known as natural language processing (NLP)
which involves teaching machines to understand, interpret, and generate human language.
ChatGPT is trained on massive amounts of text data and can generate text in response to a
prompt, allowing it to answer questions, complete sentences, or even write articles and poems.

B tistend explain Newion's Laws

B8 5 e v, e Englh mathematian,pysii:,and sstronomer, e
three fundamental laws that describe the motion of objects. These laws, known as Newton's.
Laws of Motion, laid the groundwork for classical mechanics and have been essential to
understanding how objects move and interact. The laws are as follows:

1. Newton's First Law (Law of Inertia)
An object at et will stay at rest, and an object in motion will stay in motion with the
same speed and direction, unless acted upon by an external force. This law states that an

Image and video generation

An image generation model is capable of generating unique and diverse images from textual
descriptions, such as “a three-story castle made of ice with a unicorn statue on top” or “a toaster
that looks like a spaceship.” Itis trained on a diverse range of images, allowing it to generate a
wide variety of creative and imaginative outputs. This technology has the ability to generate
detailed and high-quality images, which can have potential applications in fields such as video
game design, film and animation, and advertising

Al can create videos. Al algorithms can generate animations, insert computer-generated
graphics, and even create videos from stll images. However, the quality of the output depends
on the sophistication of the Al model and the amount of data it was trained on. Currently,
Al-generated videos are often used for special effects in movies and video games, as well as for
creating realistic simulations for research and training purposes. Some companies have also
developed Al-powered video editing tools that can automatically trim, stabilize, and enhance
footage.

Whatis the Digital Divide?

The Digital Divide, or the technology gap, is a social issue referring to the
difference in the amount of information available to those who have access
to computers and the Intenet and those who do not have access. The term
became popular in the late 19905 and while this gap should have been
closed by now, it is just getting worse. It’s simple. Not everyone has access to
the latest technology, or any at all.

Broadly speaking, the gap is not necessarily determined by the access to
the Internet, but by the general access to ICT (Information and
Communications Technologies) and to the media that the different
segments of society can use. Today the most discussed issue is the
availability of high speed access to the Internet at an affordable cost
and quality. But, the problem should also be discussed inan
international context, where specific countries are far more
equipped than other developing countries to exploit the benefits
from the rapidly evolving technology. The idea that some

and are vital to
quality of lfe is not new. Some suggest that the Internet and
other ICTs are somehow transforming society, improving our
mutual understanding, eliminating power disparities, and
allowing us to live in a truly world society.

The digital divide is not a clear single gap which
divides a society into two groups. Research shows that
disadvantages can be lower-performance computers,
lower-quality or high price connections, difficulty in
obtaining technical assistance or training, and lower
access to high quality online content. And of

course, the term doesn't have the same meaning

for everybody. For example, in the USA people

talk about the digital divide and the main talking
point is that a quarter of the country doesn't

have high speed Internet at home. It is not that

a quarter of the people do not have

smartphones or access to a connected

computer in their local community.

Musicgeneration

Al can create music using various techniques, such as machine
learing algorithms, generative models, and other computational
methods. An Al system, like MusicLM from Google, can analyze
existing musical patterns and generate new compositions based
on that information. Some Al systems can also generate music in
real-time, responding to specific parameters or user input.
However, the quality and originality of Al-generated music is still
amatter of debate, and many experts believe that human
creativity and musical expression cannot be fully replicated by
machines.

Games are intelligent

Al has been used in gaming for many years to enhance player
experience and improve game design. Now, the evolution of machine
learning systems is radically changing the gaming industry. Al improved
the visual quality and now game environments have become more
realistic than ever before. Game characters move and express
themselves in a natural way.

Here are a few examples of applications of Al in gamng:

Non-player character (NPC) behavior: Al is often used to create more realistic NPC behavior,
such as more intelligent opponent Al, which can make the game more challenging for the player.
2. Procedural content generation: Al algorithms can be used to generate game content, such as
levels, terrain, or random encounters, based on predefined rules and player behavior.

Personalization: Al can be used to tailor the game experience to individual players based on
their playing style, skilllevel, and preferences.

&

Real-time strategy: Al can be used to create more intelligent and dynamic game environments,
such as intelligent resource management and adaptive difficulty levels.

w

Natural Language Processing: Al can be used to enable voice recognition and natural language
processing, allowing players to interact with NPCs and the game world in more immersive an
realistic ways.

Weather forecasting

Al can provide more accurate and up-to-date
weather forecasting information than traditional © Seattle

methods by analyzing large amounts of data from ., S
various sources such as satellites, radar, and weather B2 sunset 1920
stations. Al algorithms can create highly detailed and 0w
localized weather forecasts, taking into account 5 25" £ 0w
specific geographic and environmental factors. The e e f;’ :‘;‘;n‘:“;
faster and more frequent updates can help in . “

providing early wamings for severe weather .
conditions and improving disaster response and -
planning. Additionally, Al-powered weather
forecasting systems can automate many manual
tasks, freeing up meteorologists to focus on analysis
and interpretation.

25 g e
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When working with computers and other electronic devices, problems are bound to occur at one point or
another. Wouldn't it be great to know how to deal with them? Here are some of the most common problems
for most home users' setups and ways to deal with them.

oris weird

When something appears to be frozen, first find out if only the (7= e
current program s frozen or Windows is entirely unresponsive.

If the mouse pointer is present and is moving when you move.
the mouse, then the problem is just with the program you are
working on. Right-click a blank area of the taskbar and click
Start Task Manager. Click the program in the list and click
End Task. Windows should now run normally. f the mouse
pointer doesn't move, Windows must be restarted. Press and
hold down both the @D+ keys. While holding them
down, press the (CEIT key twice. Windows will shut down
and restart.

593
®
H

If the computer is acting weird, reboot it. The majority of the
problems that occur can be fixed by rebooting. When you
reboot, the computer's memory is cleared and almost
everything is reset. This fixes a lot of problems.

i th

Check all the connections, the cables between the main unit and the monitor and all the
electrical cables. If there is  green light on your monitor but not on your main unit, then
there is a problem with your main unit. If there is a green light on your main unit but not
your monitor, then you may have a problem with your monitor. Try with another monitor.
If you have a light on both the monitor and the main unit, check the pins of the video
cable. A single bent pin can cause a problem.

The keyboard doesn’t work

> Press (D) +EET (all three keys at the same time)
to bring up the Task Manager. Select any program that says
Not responding and click End Task.

> Check to make sure the keyboard is stll properly connected
to the computer.

> Try plugging it into a different USB port.

> Shut down your computer. Unplug and replug your
keyboard. Turn the computer back on.

When you turn your computer on you may get a message
that no keyboard was detected or you get into Windows
but you are not able to type. Unplug and plug again the
keyboard. Use a different USB port. I it still doesn't work,
try another keyboard that you know is working.

Cleanyourkeyboard! One of the dirtiest
parts of your computer is the
Youhave to clean it regularly and this will
also help in working properly.

The mouse doesn’t work

Make sure the mouse is properly connected to
the computer. Plug it into a different USB port.

If your mouse doesn’t work, use B+ to save

your work and () +@ to close the application.
BT %

If you use an optical mouse, make sure that the e =

desk surface can reflect the red or blue beam of

Remembertouse e
the mouse. A shiny surface or glass may cause et o2
problems. defragment tool
onlyfor, AW [Fr—
drives (HDD) and ==

If your keyboard or mouse are wireless

check the batteries.

ot for ST
drives (SSD).

Th is | i . —

Hard drive fragmentation may slow down your
computer. When was the last time you
defragmented your hard drive? In your hard disk
properties, in Optimize and defragment drive
section, click Optimize. @ In the Optimize
Drives window, choose the disk you want to
defragment and click Optimize.

If you are running low on hard disk space, your LR G
computer will also run slowly. Use Disk Cleanup | e

to empty the Recycle Bin and delete
unnecessary files that the system keeps on the
hard disk drive.

d

does tup

> Check for forgotten USB flash drives plugged into the computer or DVD disks in the drive. Remove and try
again.

> Try turning the computer off and then on again to see if the problem persists.

> A peripheral device might be causing the problem. Try disconnecting all devices (except the mouse and
keyboard) and try again. If the computer starts normally, you have to isolate the device that is causing the
problem. Shut down, plug one device at a time and restart to find out the faulty device.

> Check to see if your computer is overheated. Ifitis, shut it down and wait for it to cool down before trying
again.

> If the messages “A hard drive is missing” or “Operating system is missing” appear, don't do anything. Call for a
PC technician to take care of the problem. You may cause a bigger problem by trying to solve it by yourself!

Thereis nosound

> Check that the speaker or headphones cable is
plugged in correctly. All audio ports and cables
are color coded to help you.

> Check the mute button (both on speakers and
Windows taskbar).

> Check volume sliders (both application and
Windows master volume).

T Line in

[T Microphone In

W Main/Front Speakers Out
(or Headphones)

Rear Speakers Out

Center Speaker /
Subwoofer

> Check the volume knob on your speakers. Side Speakers Out
> Check if any forgotten headphones are plugged in.

> Bluetooth speakers are connected to the computers.

> The computer has recognized your monitor as a speaker. Switch to the normal speaker.

100

Computer viruses

Let's learn some more things about viruses 5o we know what we are up against. A
computer virus is a set of computer instructions that self replicate. A virus can be a
complete program (a file in itself) or a piece of code ~just part of a computer program file.
In its most basic form, a virus makes copies of itself.

Through the process of making copies of tsel, a virus can quickly use up all available
memory in your computer. This can slow your computer down significantly and sometimes
prevent other programs from running at all.

Most viruses also contain code that does something destructive to your computer, or
someone else’s. It can destroy or change your data, change your system settings, or send
out confidential information.

How viruses spread

Most viruses require human intervention to start
replicating. You may trigger a virus to begin replicating
when you click on an infected email attachment. Once
avirus is activated, it can create and distribute copies
of itself through email or other programs.

Your machine can be infected by a virus if you:
Share infected CD-ROMS or DVD-ROMS.
Download and run infected software from the Internet.

Open infected email attachments.
Open infected files on a USB drive.
Plug in an infected USB stick

Visit a malicious website.

Itis important for you to understand that, once a virus
infects a file on your computer, it replicates and spreads to
other files on that computer. If, however, this particular
machine s part of a home or business network, it can also
infect other computers on that network.

Worms

Worms are often confused with viruses, but a worm has the
ability to travel alone. Viruses require human intervention
to start replicating. A worm can make copies of itself on a
network or move by itself using email without your help.
Awormis usually a standalone program. A worm transmits
itself between machines across a network.

Avirus attaches itself to files. When a virus copies itself, it is
copying itself to other files on the same machine.

Ransomware

Ransomware s a form of a malware that encrypts a user's
files. The attacker then demands a large amount of money
as a ransom from the victim to restore access to the data.

Protection measures

To protect your computers and your home network against these threats, you should
make sure:

> You have an antivirus program installed on every computer on your network. Windows
Security is a highly efficient and lightweight choice that protects you silently with no
annoying pop-ups. Plus, it's free.

> Your antivirus program is configured to download updates automatically so that you are
always protected against newest threats.

> Windows Firewall is enabled.

> Your computers are updated with the latest security fixes through Windows Update.

Why do you think
you have a virus?

If your antivirus software found
avirus in your computer, it
might be a false alarm.

Listed below are some common false alarms:
Ll The virus is not in a list of common viruses.
JA Virus is found in memory only and not in any other file.

You have more than one antivirus software in your
computer.

B The antivirus doesn't name the virus it found.

If you have one of the following
problems in your computer and
you think it is a virus, then you
may be wrong! You may have
just problems caused by your
computer hardware, software, or
just errors that you have made.

The computer is very slow.
The hard disk drive light seems to blink for no
particular reason.

USB Flash disks can't be written or read.
Strange web pages appear on the screen by
themselves.

#Hands on!

Match the terms with their meanings:

TERM MEANING

[wep | | A user with limited access rights ]
[weaz | [ An unsafe wireless encryption protocol ]
[ standard user | | A malicious program that transmits itself through networks |
[ Admini: | [ A user with full access rights ]
[virus | | A'strong wireless encryption protocol ]
[ worm | | A self-replicating piece of code ]
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MODULE 2

Collecting information

Hi and welcome back! It's time to explore a really big topic in computers,
which is called databases. What is more, you will learn the real meaning of
the words “information” and “data.”

Learning Objectives

In this module you will learn:

 Skills

After this module you will be able to:

> what the meaning of collecting
information is. > organize your information into

> how to gather information. tables.

> use filters and sorting.

> understand the importance of
primary keys and relationships.

> create and use your own database.

> how to import data onto a
database.
how to extract certain information
from a database. > import and export personal
information from your contacts.
> use a data logger for lab
experiments..

Microsoft Excel

> how to identify certain information
in a database.

> how to relate different data.
what the meaning of personal
information is.

> how to extract data that contain
personal information.

> how to use databases in labs and
experiments.

> Outlook.com

> HanDBase

> Memento

> Obvibase and Caspio

contacts - Power Query Editor
B tove | Tenstorm  Addcoumn  View

o DaaTpeTen~

[ Use First Row s Headers ~

&
&
Reduce St Group |

Close & Refresh

o Combine _ Manage
Preview ~ Rows ™ Column~ gy zReplace Values ~  Parameters~
close Query sont Transtorm Parameters
Jo || = cov.ocument (Fite.contents 8| G
. | D A% Columm <] 4% columnz ~ %% column -
¢ 4 PROPERTIES
] First Name ‘Widdle Name Last Name
- Name
B Coms e e acts
Q-
4 APPLIED STEPS
. Source
» Changed Type
e |G B B R 8| fe S 7
@ hese e | Bcomentonge | B | et o et o Now that you know
e - et e e s how to export your data
P - from Outlook.com,
A 3 c 3 e why don't you try the
°< it ame £ i s 3 obiePhone B Home sveet il other way around? Try to
2 [t 2125008412 22 Aled Drve 3
3 im@digitalk 2125002020 36 Cambrige Court import data from a
b 2125004321 44 oo worksheet which contains
s 2125001234 2048 Cenral Avence 3 4
. tom@binarykdscom 2125002020 36 Cambridge Cout | contact information
7 to Outlook.com.
s

Now you can apply the things you learned
about databases to make your contacts
database look better, sort t, apply filters, etc.

#+Hands on!

Use the things you learned in this task to create your own contacts database in
Microsoft Excel. Export your contacts from your email program and import them
to Microsoft Excel, just like we demonstrated. You can use more fields than we did
in the examples if you want. Then, sort your contacts by name and save your
database.

TASK 1

Introduction to databases

Ona student card, you can see information
such as the student's name, home address,

Do you know exactly what data is?
Data telephone, email and date of birth.

any kind of information around us!
Information is facts or details about somebody or
something and which you know or can leam about
from different sources:

DiNoaloe

GSTUDENT CAR

Let's explore some different types of data
> In the fall, most trees have yellow leaves,
> Kim's eyes are blue.

> A car has 4 wheels. o
> Today is Sunday.

> Anna's favorite food s spaghett sionAT

When a set of data is gathered, it can provide organized information about something specifict

For example, the data a school gathers about its students makes up an organized set of
information. Before computers, this type of data was usually kept i filing cabinets.

information” and “data” in

In the 1970s, compt i
words. “Data” means information that has not been checked. “Information”

TASK 5

Lab data collection

In your school's science lab, you can work on many different experiments. Some of these
experiments involve taking measurements. Data loggers are designed to do just that: they are
devices with sensors that help you measure and record data, such as light, sound and
temperature measurements.

A data logger can take repeated measurements and then transfer the data to your computer

for analysis. Just connect your data logger to the USB port of the computer and download the
recorded data.

With a data logger, you can capture and display data
as it happens, collect data continuously or at regular
intervals over long periods of time. One kind of data
logger is a weather station, which records everything
about the current weather conditions. Scientists can

then use this data to predict changes in the weather.

Using data logging software, you
can display the data as a chart.

After you take your
‘measurements with a data
logger, you can download the
data to the data logger’s
software on your computer.

What you can do with a data logger:

Accurately measure sound and light as well as temperature.

Take measurements that are too slow or t0o fast to record by traditional means.

Collect data anywhere and then download the data to a computer for analysis
Get visual feedback of your measurements.




Databases

Sample pages

28

To insert records in your form

> Simply fil in the form you o | s e KOy T | g i
have already created. @ | e [ e b3 ~ o
> When you are done, on the Al Access Objects® -
Home tab, in the Records ‘:"" ¥
group, click Save. @ o

T —r

Use this. Use this ]
buttontogo button to go ) L=
tothe T tothe BT

record. record. " i

This button Thisarea This button Inthe same way you enter datanto
takes you to shows the takes youto aform, you can also enter data into
the| e [Current L ext) atable. Open the Students table
record. record. and type these records.
StudentiD = Name - Address  «| City - Fostal Code - Telephone number « | Class No « Cick o

1Marco 44, Woodrow Way  London 2125 2

2lsa 26, Cambridge Court Stratford 12245 1

3Km 22, Alfred Crive London 12247 2

4Tom 26, Cambridge Court Stratford 12346 1

Salex 202, Newportlane london 12348 s

GStella 2048, Central Avenue London 12349 215 E

7Paul 43, OxfordSteet  London 12341 2125005262 El

o = C
To delete a record: o

> Navigate to the record you want

Moy Y |t 2By
to delete e.g. the 7th and click -
the record selector next to the o e " i =
o Al Access Objects® « [EEmm = oastnes o
record. - £| Students
> On the Home tab, in the oy
Records group, click the down @ 5
arrow next to Delete and then o ¢
dlick Delete Record. © S I

[—" x

> In the warning message box that
appears, click Yes. ©

You e about 0 dft  crd).

1 700 i Y you wont be e 10w s Dot opersion
S o w1 it e e

Because the Student ID field is
auto-numbered, when you delete
a record, its Student ID number is

Tofill in aform faster, you can press after
typing each field to move to the next one. If you press
while working on the last field of a form, you

move to the next page to insert another record!

not replaced. If you delete the
last record e.g. No 6, the next
new one will be No 7.

TASK 5

Import and export data

Import and export data are very important operations for any program and especially for
databases. Thanks to this feature, you can transfer your data from one program to another for
more processing. For example, you can export your data from a database to a spreadsheet for
analysis, or export an old database you kept as a spreadsheet to a powerful database program for
easier updating and maintenance.

[T ——

= e mgors £ el =Rt o

> In the Navigation pane, click the

object you want to export data SR B:«-« S ‘,:.‘Af ‘,':; o Dot
from e.g. the Students table. @ o e = B
You can export data from any All Access Objects® «
table, query, form, and report 5
objects. by "‘V
> On the External Data tab, in the E
Export group, click Excel. @ s
> In the Export - Excel Spreadsheet —

window, type a file name for your
Microsoft Excel file e.q. Students.
xlsx © or Browse to select
another location for your file. @

Sct the dostinntion o the dta o want o spor

T e o

> Click OK. @ o it
> That's it! Click Close on the next )
window. e

> Your data has been exported to

Microsoft Excel. D) ottt o .

fileto see
yourresults.

specific records
from yourtable.

can preserve most
of your formatting.

e Mome et Pgelnost fomus Dia Revew Viw e

B K Jom -

S
Save the steps = :
youwantto 1 SndeniD Name Addess
repeat every 5 e e
rocks ) T s
PR ity
Dl G

Personalize your forms

If you want, you can customize your form in various ways. For

instance, you can add or change fields and labels.

To change the layout of your

form;

> On the Home tab, in the
Views group, click
Layout View. @

> In Layout View, you can @ o
resize and drag all the fields
and put them in the order
you prefer. @

All Access Objedts®

| Students

W o

Change Data Source a

You can also change the Data i) vome Scose

Source of your text boxes. This _\ E..m... Nus=0a888 g
means that you can choose a | s - o
specific field in your table, so that | e | e =
the text you type in the text box Il Access Objects® « [Tmsmart
is saved in it = 2| Students
B e
@ in 7 e
To change the data source of =l o
a text boy foms 1 | =
& s

Exema Qata DatabaseToos Moo Doson Arange Format 0 Telme

> Click a text box to select it,

eg. the text box that

contains the name Marco. @
prgr——

> On the Design tab, in the
Tools group, click Property
Sheet. @

> In the Property Sheet pane,
on the All tab, click the
Control Source list and click
a field to link to that text =
box e.g. Name. ©

Now, whatever you write in
that text box will be saved in

the field you selected.

To export data to a text file using Comma

Separated Values (CSV)

> In the Navigation pane, click an object which
you want to extract data from e.g. the.
Students table. @

> On the External Data tab, in the Export
group, click Text File.

> In the Export - Text File window, type
name for your text file e.g. Students.txt ©
and click OK. @

> In the next window, leave Delimited selected
and click Next. ©

> In the next window, click Include Field Names
on First Row, @ and then click Next. @

> In the next window, change the name of the
file if you want and then click Finish. @

> In the next window, click Close. @

With this option, you
can preserve
your formatting.

S

)

Do these steps look familiar? Remember when
you exported a CSV file from Microsoft Excel?

These steps are very similar.

S
EE = 5

Fomat 0 Telme vhatycuvanttodo

[=P

e o i s i Tl st

Bt Fagaatees

Al Access Objects® «
"

[ ) ==

Ottt

) g

o

Tlephane numberclss o 7
212

vatod’ 12
12547 225004412
o 224521250620

12348 2125005162
12 21250003
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ek, "204, ol venve”,Londor
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Modifying Tab order e
informs 2 Students
When you use a form in an Access Sl ]

database, you can switch between
controls by pressing the (ZTXED key. ame =3

Usually, the controls respond to the

key logically, from top to el Mok,

bottom and from left to right, so TR
the form is easier to use. If o o Sl
necessary, you can specify the order ook — et

in which the controls on a form

respond to the key. Telephone number 7125004371

following order:
StudentiD, Name,

Address, City, Postal
Code, Telephone

To modify the Tab ordef cassho g number, Class No.
orm
> Open t‘h’e form in Design Fie Home Create FExtemolData DatabaseTools Help Form Design
View. s
A Themes~ 1+ | Biogo =/
> On the Form Design tab, in Bt i) & | B B E
view Convot Adabuisting ropery Tab
the Tools group, click Tab B | s & [Bosematine | T et onger
Order. Controls. Header / Footer ool

> In the Tab Order window,
under Section, click the
section you want to change,
&g, Detail.

> On the Custom Order list,

[
o

SIS EUBET G IR e

place the cursor above the
square next to one of the fields | mouer
on the list. When the cursor
becomes a black arrow, click to
select a field, e.g. Name, and
drag the field to the desired
location in the list, e.g. first. @
> If you want Microsoft Access
to create a top-to-bottom and
left-to-right tab order, click
Auto Order. @ s

> Click OK. @

chian

o oder.

StudentiD

ity
Postal Code

Class No
child21

102
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Splitting databases

One way of improving the performance of a database and
reducing the chance of file corruption is splitting the database.
When you split a database, you reorganize it into two files. The
back-end database contains the data tables, and the front-end
database contains all the other database objects, such as queries,
forms, and reports. Each user interacts with the data using a local
copy of the front-end database.

G (B0 =B

v s Quick access “

When you restore data from a
backup, you want to know which
database the backup came from
and when the backup was made.
Using the default file name when

you create the backup file is a

good

1 Desktop F 4

Database
& Downlosds  # Sy
# Documents wp
= piwes £

It would be best to always back up

a database before splitting it. If
you split a database and then

decide that you do not want a split
database, you can restore the
original from your backup copy.

atabase: Fle Home Ceate ExemelDato DatabaseToos Help O Tl me whatyou want to dol

@ Database Documenter e
eeed |-

> On the Database Tools Conpatiod | Vi | Resscoos e
f2binthe Move Bata oo e | B Mo e e Dosme
group, click Access e e S
Database. @

oo st =
> Click Split Database. @ el .. s";‘:“"’ e
‘Back-end catsbase. n mukuses EnveOneTS, s reces L ight
> In the Create Back-end g e v Iak:a lﬁiﬂfm
Database window, click ATl You should notify
FD_tIxumenls, ©and type a ::‘mxmm”r.:m.u users so they will
ile name, e.g. not use the
Split Database_be. @ preied et database while
> Click Split. © A yousplitit. Ifa
e ’l‘ user changes
v ) data while you
> Your database is now split. ET = split the
database, the
T %] [oatabese spiter B changes will not

et B e Oonmes Ve

Ol Nt

g R

be reflected in the

[ Jr—— back-end

database.

v Quickaccess
B Desktop *
Spit.Dat
& Downloads  # | abase_be

“ Documents  #
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Sorting recordsinaform Stadents X

In a form in Microsoft Access, you can =] Students

navigate through your records using the ¥

navigation buttons at the bottom left. P— 7

Microsoft Access allows you to navigate

through your records in a specific order. Name fercol o

You can sort them according to a chosen

field in ascending or descending order. Address 43, Woodrow Way
To sort records in a form: City London
> Open the form and click the field — TS

you want to sort by, e.g. Name. @
> On the Home tab, in the Sort &
Filter group, click Ascending. @

phone number (2125004321

> The records are now sorted reg ot 3 v 2 souh [
alphabetically according to the
Name field. © Fle  Home Creste ExtemolData DotabaseTools Help O Tell mewhi
> o ravigate through your records, ivE@ s : (o 1
click the navigation buttons at the v . i li::eme a5 el R
i) v | ot 5 o g s
> If you want to remove the sorting, All Access Obje...© ¢ | s X |
on the Home tab, in the Sort & = ¥ = students |
Filter group, click Remove Sort. @ T 5 D
@ coums Sudentid s
| @ cde e = e
Applying themes g S
s
Atheme is a collection of colors and = - ndiress 202 Newsor Lone
font formatting that you can apply to & suoens

forms in Access as you like. London

To apply a them File Home Create FExtemalData Database 1|

> Open the form you want to format 2 Themes 21090
in Layout View, e.g. Students. © Mcolors~ | (e B ite

> On the Form Layout Design tab, in [ || [E]Fonts~ v [ Date and|
the Themes group, click Themes, Controls Header / Fol
and then click the one you like, e.g. [E=] rorm view © < |3 studes X
Retrospect. @ -

> Also in the Themes group, you can

imonven ) 2 3 St
edit the theme you applied, 2 |

changing the Colors € or the FleHome Crste Exemal Duta  Database ool ey Fom Layout Dedgn

Fonts @ of the theme. Biogo B
sa g Proery
o St

Encrypting databases with a password

In Microsoft Access, as in all Microsoft Office programs, you can use passwords to prevent others from
opening or modifying your database.

To encrypt a database with a password:

> To set a password in a database, you should
open it in Exclusive mode. So, open
Microsoft Access and on the File tab, click
Open © and then Browse. ©

> In the Open window, click Documents, ©
select the database you want to set a
password to, e.g. Database 1-Backup, @
click the arrow next to the Open button,
and click Open Exclusive. @

> On the File tab, click Info. @

> Click Encrypt with Password. @

> In the Set Database Password window,
type the password in the Password box,
retype it in the Verify box, @ and click
oK. O

> Microsoft Access will ask you for the
password whenever you want to open the
database again.

=T

@ copyoun | [ @ Copoctpon | [ open eiocaion

Set Database Password 7 X
O R poemtord
Py sty =
St ks e b

g potces o G sk e

Tt o seics
jrev————

Compact & Repair
Compac | by om0 e
Separ Do

Password Required

Enter database password:

o i o]

@ ] =

Peamra | e et it e e

If you forget your password, Microsoft

cannot retrieve it. Store the passwords
to your documents in a secure place.
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Cybersecurity BINARY
E-commerce I CT
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Information security Digital Business
Personal and computer security

Digital footprint and Internet security
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Design your website
Publish your website
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Creating custom infographics

3. Video production
Video shooting
Video editing
Visual effects
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The final touch

3D animation

4. Digital marketing
Plan your marketing strategy
Email marketing campaign
A brand blog
Create blog content
Blogging and social media
Social media audit



Sample pages

MODULE 1

E-commerce
and Cybersecurity

In this module, you are going to learn the importance of e-commerce and its
various models.You will learn about the different technologies used in
e-commerce and how you can perform financial transactions safely on the
Internet. You will also be able to protect the information you enter online
from unauthorized access, by distinguishing between the different types of
attacks. You will also be able to assess the impact of your digital fingerprint
over the Internet and understand the use of operating system functions for
safe browsing of the Web.

TASK 1

E-commerce

E-commerce depends on
many technology systems
«and tools such as:

E-commerce s a term that refers to all forms of commercial
transactions that take place over the Internet. Usually,
e-commerce uses the World Wide Web in order to complete Email
commercial transactions. Campany confent
One of the most famous examples of e-commerce s online management systems.
shopping, which includes the processes of buying and selling
products as well as transferring money and data to carry out
commercial transactions using various devices. E-commerce
often includes procedures like the sale of physical products over

Instant message exchange
systems.

Newsgroups.

the Internet, but it can also be used to describe any type of Online shopping systems.
Learning Objectives m procedures and business transactions that are completed over Product delivery tracking
the Internet services.

In this module you will learn: After this module you will be able to:

> What e-commerce is and its basic > recognize the basic models of Online banking services.

models.

> What virtual goods are and how
you shop online through the
Amazon platform.

e-commerce.

> use Amazon platform for online
shopping.

> pay safely online.

> What the e-commerce
technologies are and by which
methods you can pay online safely.

> Which fraudulent operations to
look out for and their warning
signs.

> What information security is.

> What cybercrime and security m
breaches are.

> How to follow personal security
precautions.

> What kind of personal information
you share online.

> What a digital footprint and digital
traces are.

> What kinds of personal data a
browser collects.

> understand what is cybercrime and
security breach.

> understand what kind of
information can you share online.

> protect yourself from internet
frauds.

> Amazon
> Microsoft Windows

Electronic payment

Q gateways and online tickets.

7
Protection triangle
TR The primary goal of information security is to focus on providing balanced data protection in
terms of its confidentiality, integrity, and availability (this is known as the CIA Triangle), with a
I nformation secu r.t focus on effectively implementing information security policies, and we will now look into the
Y details of each of these elements.
Confidentiality
Confidentiality is the provision of data and information only to persons
The concept of digital security relates to protecting computer hardware, networks, programs and data concerned with it and who are allowed to see it, and to achieve this, various
from unauthorized access, which may aim to obtain or extort money from users, alter programs or methods are used such as username and password, lists of persons with
destroy data, and sometimes even disrupt an organization's operations in general. authority, and other methods of maintaining the confidentiality of data.
Information security Integrity
The term information securty expresses all practies that are caried The term integrity refes to preserving the accuracy and authenficty of
out ‘°hp'°‘°;‘ e e ‘:; ls‘ a ’95;; rom information, ensuring that it can only be maodified by persons authorized to
:"a“‘ orized access 0"“efP"’P°5€'° P cation, do 0, and methods of maintaining the integrity of data and information:
estruction, copying or falsification of information. Digital security specifying permissions, encryption, etc.
competencies can be summarized in the following points:
> Protect enterprise data and everything related to the preservation Availability
and use of that data. .
Availability means ensuring access to information in a timely and reliable
> Protect the business continuity of the organization. manner for its use, as it is taken for granted that any information system has
> Enabling the safe operation of applications built on the to provide information when needed in order to fulfil s primary purpose.
enterprise’s IT systems. Examples of measures taken to ensure the availability of data and
information include maintaining the integrity of the devices hosting the
The importance of information security data, backups, system updates, and improving network efficiency to
facilitate access for users whenever possible.
The importance of information security increases with the
increasing importance of data and information available on the
network and the necessity for its availability to users without
interruption, in addition to the number of users who need to
access that data and information on an ongoing basis. The more . o
important the information, the more it is vulnerable to computer || Integrity Confidentiality
piracy attacks that aim to steal it or block it from users, etc.
The important role of information security is to prevent, detect and
respond appropriately to internal and exteral threats as necessary.
The IT departments in the various institutions are concerned [ T T T
with developing the information security strategy for the
enterprises through:
a) Improving awareness of information security issues through
training and various initiatives related to information
security. Availability
b) Improving information security policies with continuous
reviews to meet ever changing security requirements.
d) Establishing and implementing necessary control measures
and procedures to reduce risks. --—
€) Monitoring to measure the performance of controls and i ——
control methods.
24 2
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Using search engines and social networks to search for personal Sources of and personal can be
information obtained by searching for the person on Twitter, Facebook and Linkedin.
One of the important benefits of the Internet is the presence of a large amount of information, but — — ==
there is a downside which is that anyone can put information on this network. % 5 K ﬁ
8 rops/mmtnbookeomipaicuey. O %

The biggest challenge when using the Internet is not only in finding the appropriate website that
contains the required information, but also in the need to verify the correctness of the information
that you find.
There are many ways to find personal information about people, and all you have to do is define e
the scope of the person's search, or in other words, know where to look. = |

o
The search can be done by typing the full name, or typing the last name in a search engine such as e
Google, for example, Bill Gates, and then the search results can be examined to find web pages 14 soout ’
containing family information, Facebook pages, or photos. e

s ) om0 i -
This search result provides a wealth of free information available for anyone, as detailed ad Foom e
information can be obtained easily, but you can also know the academic history of the person, E=T= W -
friends, beliefs, influencers, and even contact information r—

G Wdnw-Googhsemer x| = a coNTACTINFO.
€ O [ B hie/mmgemgecomsmactuse-rpti-pea P rSp——
e x ¢ =
S T S —_ x am o

S s 309 50 e o Bacons s

- o+ D e % [0 =%
Bil Gates - YouTube. €O 8 Mysmatedncaminitinrguey = Following
¥t vimchnlomtonagnit oy i

Influencers ~ Companies ~ Schools

Satya Nadella &
CEO at Microsoft

7,390,043 followers

s gams
Bil Gates - Microsolt, Family & Quotes - Blography

e B G Furcd e v’ et e s, it wih Pt
N, sy becams e e s en vt

B soromcems x|* - x
C T y ;
2 e ] Richard Branson B
GatesNotes e we [@w] Q = - il Gates B3 o Founder at Virgin Group
p— . e —

[

59,487 followers

About Bill oo o

Melinda French Gates J e
Three Frrmm—
Microsoft,
R geiae Gales Contact Info - [
% | B sills Profile
! 5 e
2 3
Comparison e - Visualized numbers
It is a visual way to compare and contrast different w — a2 It adds images to statistics to make them more
options. It is excellent for highlighting differences »a appealing. It is most appropriate for making
between two similar things, emphasizing similarities —— Wi individual units of information visually interesting. Visual résumé
between two dissimilar things, and proving that one w07 Itis a résumé in the form of an infographic.
option is superior/inferior to the other. — 93 Itis best suited for industries that are open
to non-traditional résumés, such as
advertising, marketing, tech startups, and
H& graphic design.
Map/Location
il oo f—)e l
relation to a geographic area. It is preferred 100% 45%
when you want to compare places and )
cultures via setting-centric data.
It summarizes the steps involved in
making a product or describing a
Photo-based/Photo-graphic process chain. It helps your audience
Itis based on a photo, uses text and data to y 4 sinsiee s conciet Dot eunploxsss
i of instructions or information.
explain a point, It i suitable for creating
brochures and explanatory posters :
ww archical
PRPRPN It organizes information by levels - whether it . s
™™ be level of importance, level of difficulty,
income level, &tc. i< o< apprapriate fok Interactive infographics are great for maximizing engagement as the
PRRFFF  comparing thedierentevels withcochcther viewer can interact with the data. They are ideal for sharing information
and bowing the'relationshily between them, across multiple digital platforms and devices
Anatomical
It breaks down complex information
and explains it in a visual and BN -
effective manner. It is ideally suited to -
biology, health, education and
marketing.
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When creating a good infographic, you need to
strike a balance between presenting enough

- 1. Choose a topi
Choosing a topic is the first step in designing
infographics. Choose an interesting topic
that can be easily supported with the right
sources of information and data.

3. Define your goals
to give the infographic

a purpose and structure.

4. Collect the data.
During the second stage, two main tasks are taken
J into account:
/\/ a. Gathering reliable information and data.

Itis done by researching various sources from
@ search engines on the Internet to books and
©) 5. Design. . ;
other sources, taking into account the variety of
a.In design planning, ideas about the topic data and information gathered, including text,
are elaborated upon in advance and then  digital information, data, images, geographic
presented in an appropriate and maps, diagrams and more.
simplified way through various form
elements such as models, images, icons,
and text content, focusing on the fact that
the main idea of the topic should be
simple and attractive.

Infographics design stages

information and not overdoing it

9()Q. 2 Define your audience.

Depending on the audience's
prior knowledge, determine
the content.

b. Sorting and refining information and data.
Itis done in order to access scientific material
that can be used in its final form.

b. You also have to select the appropriate
design tools to create the design through

various programs and websites that help
in designing infographics. 6. Review and Share.
After you design and review

your infographic, you can share
it via email or social media

Infographics design tools

Have you thought about how infographics are used to help share data and
information? There are a lot of infographic makers for creating an infographic from
scratch. Some are easy to use and some are more complex. Here you will get an
idea of what you can do with the Canva desktop application.

Canva s an easy to use, graphic software that gives you access to a wide range of
open source photographs, graphics and fonts. With Canva, you can make complex
ideas and large amounts of data easy to understand. It s free, but you can upgrade
your account for access to premium tools and content, anytime. You can download
it from https://www.canva.com. There you can also find a ot of information and!
o examples. The designs and projects you start with Canva on one computer can be
accessed and worked on from any other computer that can connect to the Internet
and go to https;//www.canva.com.

You can create an infographic, which contains simple icons, maps, symbols and
charts. You can use text as labels or to briefly describe facts. The viewer will explore
the content by studying the images and symbols in each section of the infographic.
Itis simple and enjoyable. Let's start!

Chroma Keyer

A cool feature that you have already heard about and have seen in movies, is blue/green screen keying,
This is when you shoot something in front of a blue or green background and then combine what you've
shot with another video or image. The video can be something that you've taken with your camera or a
3D video that you've created.

To add a chroma keyer
effect

> Put your video or image
with the blue screen in
the first track and your
video or image that you
want to have as a
background in the second
track.

> Click the Event FX
button.

You can use the [XT]
button to add more than

oneeeffect to your clip.

> From the Plug-In
Chooser - Video Event
FXwindow, select the
effect Sony Chroma
Keyer, © and click OK. ©

> See how the two videos
or images start to blend.
On the Video Event FX
window, on the Chroma
Keyer plug-in @ tweak
the properties a lttle bit
to achieve your desired
result. @

> You can use the Pan/
Crop plug-in @ in order
to pan, rotate, zoom or
crop the selected clip. Use
the buttons on the left
side of the window @ to
make changes to the clip.

buttontoremove the
‘current effect.

> When you have finished
close the window. Your
effect has been applied to
your clip. @

You can open the Pan/Crop
plugin by clicking the [T
[T button.

If you apply an effect to your
clip the EYTIZX button wil
become green.

To create an infographi

> Open Canva.
o

> In the Home page of Canva, click on Infographic. @

> Create an account and logi

Canva

Popular for teachers and students

&

PRESENT OV
WITH R *THE®
e
Presentation (169) Infographic Poster A4 Document
Color effects

Apart from transitions you can apply color effects. Color effects allow you to correct
any color mistakes or “dress” your clips with colors to change the mood. For example,
if you make a clip about the jungle you may want to enhance the color green.

To add a color effect

> Select the lip or the
clips on the Timeline that
you want to add an
effect to and click the
Event FX button. @

> From the
Plug-In Chooser -

ideo Event FX window,
select the Color Balance
effect @ and click OK. @

> On the Video Event FX
window, tweak the
properties @ a little bit
to make your clip look
like a really old tape. @

> Your filter will be applied
to your cl

You can choose the
appropriate presetfor
theselected effect by

clicking this button.

Color correction is a good effect
tofixany unwanted problems
Inyour videos. Most of the

‘Tweak these propertiesalittle
to see the result.
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